MXview One 1.2.0 User Manual

Version 3.0, July 2023

www.moxa.com/products

MOXAN\

© 2023 Moxa Inc. All rights reserved.


http://www.moxa.com/products

MXview One 1.2.0 User Manual

The software described in this manual is furnished under a license agreement and may be used only in accordance
with the terms of that agreement.

Copyright Notice

© 2023 Moxa Inc. All rights reserved.

Trademarks

The MOXA logo is a registered trademark of Moxa Inc.
All other trademarks or registered marks in this manual belong to their respective manufacturers.

Disclaimer

e Information in this document is subject to change without notice and does not represent a commitment
on the part of Moxa.

e Moxa provides this document as is, without warranty of any kind, either expressed or implied, including,
but not limited to, its particular purpose. Moxa reserves the right to make improvements and/or
changes to this manual, or to the products and/or the programs described in this manual, at any time.

¢ Information provided in this manual is intended to be accurate and reliable. However, Moxa assumes no
responsibility for its use, or for any infringements on the rights of third parties that may result from its
use.

e This product might include unintentional technical or typographical errors. Changes are periodically
made to the information herein to correct such errors, and these changes are incorporated into new
editions of the publication.

Technical Support Contact Information

www.moxa.com/support


http://www.moxa.com/support

Table of Contents

B 11 o Y« [T ot oo o e 6
L == L L8 = PP 6
LUL=T o o= 1=Te I @ o 1=T = u o o N PP 6

Auto Discovery and Topology Visualization ... e 6

LY oY =T g =T =3 o 1< o | PP 6
Configuration and Firmware ManagemEnt ... ..ottt e e e e e e e e e e e e eaaeaenes 6

L= i (ol [T oY1 o T o [ Ve PPN 6

ST =T 0 T R LU 1 = o g L= = PPN 7

YU o] sleY nt=Ta I D 1A/ Tl =T PP PTPR 7

2. Installation and UnNiNsStallation .....cccicicrorerrrararamssisssisissssesesesssasasasasasasasasassssssssssssssssssssssssssssnsasasasasasanas 8
LTS =] L= Lo o T o oY= [ = 8

Lo AT T T [ 1= 8

[T g 1o 10 0 0 02 P 8

FOr UbUNtU 18.04 @nd 22.04 .. . eeieiiieiiie ettt ettt s e e s e e s e s e e e e e a e e aen e aen e e e e e e e e e e e e ennnens 8
L0701 3 =11 = ol [ o PP 9

Lo AT T T [ 1 9

Lo 110 11 | P 9

I 1= 1 4 T T - T =« N 10
N YT @ =T o o] I == T 1= PP 10

1S Y7 @] oLl g'o ] 10

(o] a1 To T =1 o Lo o S PR 11

(D] R = Yol U] B =T o o PP PPPN 12

([0 Te Lo T =T = T 1= PP PTPN 15

(=T 1 Tor= o TP 16

Starting the MXview One Server and Logging Into MXVIEW ONE ...c.iiiiiiiiiiii e eas 20
Logging INto MXVIEW ONE REMIOTEIY uuiitiitiiiii ittt e et e et e et e e e e e e e e n e e aennenenes 22
[0l T=T = 7 = =T 1= o 1= o PP 23

(@1 g 1Yol g o o g T I Tol= o 1= PP 25

P Lo 1T g o T T Lo I Tl = o 1= = PRSP 25

USING DEVICE DiSCOVBIY uiiutitiittite it tattateasere it tattasssae e taesassassrseaaeaaseassssesaseassaseasesneannsnsssnssnesnesnnsnnennennes 27
oot ]8T a1l =1 g F= T =T =T o | PPN 29
PXe Lo 11 g To U E=Y=T o Vool ] U] o) = PRSP 30

[\ oTa [} 3V T aTe LU £-Y=T ol 2 olelo 18 o 1 = PRSPPI 30

(D (=i o U Y= ol Vol ] U] o) PP PP 31

[=bqnToT mul aTe B =TT Yol oo ] U o | (= PPN 31

Configuring the PassWord POlCY .uuieiriie it e e e e e e e e e nneaenes 31
Configuring Login NoOTifiCatioNS ... .uiui i e 32

Changing the Display LanQUage ...c.iueirieiiii ittt et ettt e e e e et st e e e e e e e e aenennenenes 33

4. LT o= T = T = Ve =T 40 T= o L 34
License ManagemeEnt OVEIVIEW ...uuuusisititititisisisisit sttt e e e e e s s e s e s et s e s e s s e e s e e et e e e e e e e ens 34
[Tl g =T NV = 35
Ve Fa g I T A = I Tl =T T PP 36
Ve o g =T o X [a T o B Il o T PP 38

[ 7=T= T V2= L o = T I o= o =T 41
Reactivating @ Deactivated LICENSE .....u.iuiiiiiit ittt et e st a e s s e e s a s e e s e s e e s e e aneanen 42
Transferring a License to a Different Instance of MXVIEW ONE.......iuiiiiiiiiiiiiiiiiiiiir e aeaas 44
Quantity of Monitored Devices Exceeds the Number of Node-based LiCENSES.........cveviviiiiiiiiiiiniiieeans 46

5. Dashboard Widgets ...ciueiiiiorirrr s s s s s s sa s s e na s E o Ea S E SRS NSRS NSRS R RA RS RRRRRRRSRSRRRRS RS 48
D=1 a1 oo T= e B @ XY= T o VA 1= PR 48
[Tl U o 2 =T o 48

oY= T o |l [ Te ] ][ o o= PPN 49

6. Device Discovery and PoOlliNg ... s s sss s s ssssssssssssssssssssssssssssssssssssssssssassssnssnsnss 50
DEVICE DiSCOVEIY OVEIVIEW 1.uututisisitisisisisissssssssssssasasa sttt et e e e r e s e et e s e s et e s e s e s s s s e s e e et e e e e e s eens 50
Configuring IP Address SCAN RANGES ...cuuiiiiuiiiiiiiii ittt r s e s s e s a s e e e a s e e s a s e enanrenens 51
Configuring Device POlliNG SETEINGS . vuiuitiiiiiiiii e e e e e s e e a e e e a e ens 53
Changing Default SNMP Configuration .......ciuieiiiieii e e e e s e s e eaea e ens 54

(@l g =T oo 1o To I\ ToTe o TU T WO =] ] u o T =P 54



28 oY 5 Yo Lo e AV =T 0 T e 10 1= 3 56

BT 0o] oY | @ T V1 PPN 56
VAT g T o] o o] oY |V 1 =T o J PP 57
VIeWING RECENTE EVENTS ...uiiiiiiiiitiiii e e e e ettt ettt e e e e e e es 59
Organizing the Topology Structure By Group FUNCHION ......iiiiiiiiii i e e 61
(2 Te (] o F=Y o) ol o] o] (o | 1= PPN 64
POE Power Consumption ViSU@lIZation .. ....uu et e e e s e e e e a e e 64
AV N VT [ Y A U [ 2 Y o o o P PP PP 65
[T o I 0T 0 <o T PPN 65
AddiNg DEVICES @NA LINKS ..uuuienieitiiiitieiitie ettt s s s e s s s s e s s s s e s s e s e s a s e e e a s e e sa s et an s et st sanananns 66
Deleting DeViCeS @Nd LINKS ...uuiuiiiiieitieiitieie sttt e st s ea st s e e s e s e e s s s e e s e s e e s e s e e s e s e an s e e anaenen 68
(6] oY =TT aTe IR o a T KoY o o] (o VN i - T o J PPN 68
Refreshing the TOPOIOgY LayOUL......i.iuieieitieiitiii et e e s s s e e s s s e e s a s e e s e s e s s e enansanen 69
Creating @ NeW TOPOIOGY MaAP ...uuiuiiieiitieiitieie ettt e s s e s s e s e e e s s e s e s e e s a s e e e a s e e s a s e eneasenens 70
Setting/Editing the Background IMagE .......c.iuieiuiiiiiiiiiie ettt st e e e s s s e s s e e s a e enaasanens 71
[=le[1u[aTe Iu T KoY o] oTe VA Yot o l=T- = Lol PPN 72
Editing the DeViCe APPEaIANCE . ..uuiuitiiiiit ittt st st st st s et s s st e s s s e e s s s e e s a s e s s e e snsasenansanen 76
(=0T uu [aTe IRu a T WY o] (oo |V 1 = o J PPN 78
8. Network and Traffic MONItOriNgG .cu.cioiioiiirire s s s s s s s s s s s s s s s s ssa s ssanansnnnnnasnnsarnnnss 79
VIEWING LINK PrOP@Iti@S ..uuiuitiiiiitiiii i e e st s s e e s s e s e s s e e e a s et s a s et s a s et et saenanns 79
VAT LT T o o v I = | Lol PPN 80
VAT LYo =T o ol =l o] gl = | =P 81
[\ oY gV eY gl g I N o= i Toll Io =T - PPN 82
MONItOriNG NETWOIK SECUIILY uuiutiiiieit i et e s e e s e e s s s e e s a s e e s e s e e st e anaanen 82
Configuring Severity Thresholds for Traffic and Fiber Status Monitoring EVents........c..coovviiiiiiniiiiniiienens 87
Configuring CUSEOM POt Labels ...uuiiiieiiiiii i e e s e s e e b e e e a e e e e eneas 90
9. SFP Fiber Status ..icicicrorerererraririmisisisisisisie s sase s s s s sasanasassnsssssssssssssssssasasasasasasasasssasassssssssssnnnnnnnns 91
Viewing the SFP Fiber Status in Table VieW ..uiiiiiiii ettt e e e e e neaean 91
Synchronize the SFP Threshold From the DeViCe. ...t e eaaaaeas 92
b0 TR 0 TV o= = T T T 1= 4 = 3 93
VIEWING the DEVICE LISt .ttt ettt e et e et et e et e e et e e e e e a e e e e e e e e e e neennaenens 93
ilaa]oTo]aulale DIV Tolc I @fo] o i To 8] =) o [o] o = PP PRP 96
[=qoTe]mulale i BICAVAol= I @] oV o 8 =) (o] o = PP 97
(61 Ye [ =To [TaTe I o1 0 01021 /= PP 98
(o]l o1 gl aTe IS N N o I = o BT =T V= PP PP 99
(o]l Te 18 gl gTe I o] o dl Y=l o[ Vo |- PP 100
Configuring SNMP CoNfigUIatioN «.uuuisiiiii e ettt e e et e e e e e e e s e e a e e a e e nenenes 101
Configuring PolliNgG SetiNGS . .uviuiitiiiiiii i ettt e e e e et 102
Configuring AdVanCed SetliNg S ..uuiuiiiii i e 103
[(©aF=TaTe 1 ale IR u aT=I BICAVA ol TN Lolo] o HP OO 104
SigNiNg 0N t0 DEVICE WED CONSOIES. .ttt ettt e et e e e e a e e e s e e a e e a e enneaenes 105
(T aTe 1 aTe I B IoNY [0l €] £ o U] o 1= PP 106
Refreshing the DeViCe STatus ..o et e et e et e e et e eaaaaenens 107
(D1 [T o [ B TN ol PPN 107
11. Events and NoOtifiCations ..cicicicrararararirimimisisisiereresasasarasasasasararsrassassssssssssssssssssssssssssasasasasasasasasasasasasnnnns 108
[V o ol 7 T o e [ e RPN 108
A TS T T T Y 2= o | ol o = e Y PP 108
VIEWING SYSIOg EVENES Lttt et et e e et et a et e et e et e e e e e e 110
Configuring Event Thresholds and Severity LEVEIS ... e 112

[N\ o o ot o I 1 = ol Yo Yo 3PP 116
Configuring Email Server SettinNgs ..t 116

[\ o] a1 Tot=Tulo T o I\ F=Ta =Te =T 0 g = o | AP OO PTPPEN 116
Configuring New Event NotifiCations. . ..o ae e e 117
Editing or Exporting Registered ACHiONS ....iuiuiiiii i e 118
Editing or Exporting Notification Configurations ........ooviiiiiiiiiir e ees 119
[OI8E= (o) o g I V7= o o\ 1= a = L= o 0 =T o | PP 120
ConfiguriNg CUSEOM EVENES ...t ettt e et e et e e e e e e e eanaennns 120
Viewing or Exporting Custom Event Setlings.. ..o e 122

Enabling/Disabling or Editing CuStom EVENTS ..ot e aeees 123



12.

13.

14.

15.

16.

RV AT T I V2= g o g =T o0 o 124
Backups, Restores, and CoOMPares ... iereriare i rs s rs s sssssssssssssssssssssssssssssssssssssassssnssnsnss 125
Backing Up the MXVIeW ONe Dat@base. . .....iiuiuiiiiiiiiiiiiii st s s e s e s s e e s a e e aen 125
Backing Up Device ConfigUIations .......cieieiiiiiiiiii e e s s e st s e e st s e e s e s e e s a e aneanen 126
2GS (o] g Te [ BTNV (ol @fo] | o U] =1 oo ] = PPN 128
Comparing Archived Configuration FilES... ... e e e 130
Creating Maintenance Scheduler for Database/Configuration Backups ..........cccoieiiiiiiiiiiiniiiiinieenans 132
LT TE=3 oY 4 g T 8 1 =T | =T o] o 134
ManNAging REST Ul APT KEY S vttt ettt ettt et e e e e e et e s e e e s et e s et e a e e e s et et e ennanennns 134
(= gloT=Te [o [ aTe IMVAVA=T o IRTAY AT [o = OO 135
Wireless Add-0N MOAUIE ..cicieieiuimummimsissssesasarasara e rsssnsssssnsssssssssssssssssssssasasasasasasasasasasasasnnnss 137
] Yo [Tt o P 137
R 1= 0 g T ST 10 1T = 1= o =P 137

YU 0] s o] i =Te [ B TSIV ol =T PP PTRP 137
Getting Started With the Wireless Add-0Nn MOAUIE ...t e e e ees 138
Wireless MOAUIE FEATUIES . ..uiuiiiiiii ettt et e e e e e e e e e e e e e e e e n e r e e e e a e a e a s a e nenenenenenenenen 139
Main DAsShbOArd ......c.viiiii s 139
Dynamic Wireless ClHeNt ROGMIING .. ..i.iiiiiiiiiiii e et et e et e e e et e e e a e e e e eaenes 140

1 A @1 ol BTNV Lol ST B = 1] ] o T = e 142

J A e =Y To I B = =] oo = | o P 142
Client Device DashbO@ard ........o.veieieiiii e e e nes 143
WirEIESS DBVICE SUMIMIAIY .ttt ittt ettt et et et e et e et et e e s e e e s e e e s et e s e e e s e e aa e e n e e aaeeanaennns 144
Wireless ROAMING Playback. .. couiuiiiii it et et e et et e e e e e eaaa 145
POWEr Add-0N MOAUIE. .. uumiiererererererarararsns s s s sssssssssssssssssssssssssssssssssssssssssnsssnsssssssssssssssssssssssasasasasasnnas 147
] Yo [Tt o P 147
R 1= 0 g T ST 10 1T = L= o =P 147
Supported Devices With PRP/HSR FEatUIMES.....uiuiiiiiiiiii i e e eaens 147
Getting Started With the Power Add-0N MOAUIE .....uiiiiiiii e e e e aeees 148
(Lo XYL o\ o o T L= ==Y B = PP 149
Lo 5] [o e | PP PP P 149
oL o T w0 PPN 151

(€010 1] = 1T F= o 1= P 152



1. Introduction

The Moxa MXview One network management software consists of three parts: The Main Module, Power Add-
on Module, and the Wireless Add-on Module. The Moxa MXview One network management software gives
you a convenient graphical representation of your Ethernet network, and allows you to configure, monitor,
and diagnose Moxa networking devices. MXview One provides an integrated management platform that can
manage Moxa networking devices, such as Ethernet switches, wireless APs, SNMP-enabled, and ICMP-
enabled devices installed on subnets. The MXview Power Add-on Module provides additional advanced
functions for power substation applications and the MXview One Wireless Add-on Module provides additional
advanced functions for wireless applications to monitor and troubleshoot your network, and help you
minimize downtime.

Key Features

Web-based Operation

You will need to install the MXview One on a Windows computer connected to the network(s) that are to be
managed. After installing MXview One, the network can be managed using Chrome, Firefox, or Microsoft
Edge (version 79+), without installing additional software.

Auto Discovery and Topology Visualization

Within the Device Discovery, MXview One locates networking devices with SNMP or ICMP services enabled.
MXview One can collect topology information from devices with LLDP capability and draw the topology of the
network, which shows wired and wireless connections. For ICMP devices without LLDP, MXview One can
verify the connection relationship through ARP algorithms, and help you create an accurate drawing of the
network topology. If any managed PoE switches are in your network, the PoE power output information will
also be visualized automatically.

Event Management

For troubleshooting purposes, MXview One logs events that match predefined conditions, such as link
up/down, device unreachable, or traffic overloading. The most recent events will be displayed to inform
users of the networking status. Devices and links that generate events will be highlighted with different
colors. When an event occurs, users can be notified by email.

Configuration and Firmware Management

MXview One provides an interface for managing Moxa networking devices from a central location. Users can
remotely backup or update configuration files, and upgrade firmware via MXview One.

Traffic Monitoring

MXview One can log the network traffic of network devices that have been discovered.

MXview One 1.2.0 User Manual 6



System Requirements
The computer that MXview One is installed on must satisfy the following system requirements:

System Requirements

CPU Quad-core CPU or better
RAM 16 GB or higher
Hard Disk Space SSD 1 TB or higher

e Windows 10, Windows 11 (64-bit)
Windows Server 2016, Window Server 2019, Windows Server 2022
(64- bit)
e Linux - Ubuntu 18.04, Ubuntu 20.04, Ubuntu 22.04
05 For the latest supported OS versions, please visit the MXview One
website: https://www.moxa.com/en/products/industrial-network-
infrastructure/network-management-software/mxview-one-
series#resources
Browser:
Chrome: Version 76 or later
Firefox: Version 69 or later
Microsoft Edge: Version 79 or later

Client Browser Requirements

Supported Devices

MXview One supports a full range of functions, such as network status, traffic log, and
configuration/firmware file management.

e For other SNMP-enabled devices, MXview One supports standard management functions, such as link
up, link down, and SNMP MIBII information.

e MXview One can only monitor the connectivity of devices that support ICMP.

Please check the MXview One datasheet on moxa.com for a list of Moxa devices that are supported.
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2. Installation and Uninstallation

Installation Procedure

For Windows

Execute the installation program.

2. During the installation, you can check the EULA (End-User License Agreement) and choose the directory
in which MXview One will be installed and the default language, or leave the settings as the default
values.

3. After the installation is complete, shortcuts for launching the MXview One server will be created on the
desktop and in the start menu.

/7  NOTE

If your computer already has MXview installed, please uninstall it and then start the MXview One program
installation process.

For Ubuntu 20.04

For Ubuntu 20.04 installation instructions, please refer to the Readme.txt included in the MXview One Linux
software package, which can be downloaded from the Moxa website.

There are two ways to install MXview One on Ubuntu 20.04: offline and online installation. We recommend
installing MXview One using the offline method first to avoid any compatibility issues.

If you are unable to activate MXview One using the online installation method, install the software using the
offline method.

For Ubuntu 18.04 and 22.04

For Ubuntu 18.04 and 22.04 installation instructions, please refer to the Readme.txt included in the MXview
One Linux software package, which can be downloaded from the Moxa website.

MXview One can only be installed on Ubuntu 18.04 and 22.04 using the online installation method.

MXview One 1.2.0 User Manual 8



Uninstallation

For Windows

Locate the Control Panel in Windows.
2. Under Programs, click Uninstall a program.
The Uninstall or change a program screen appears.
3. Select MXview One
Click Uninstall or Uninstall/Change at the top of the program list.

For Ubuntu

Execute the command line:

#sudo apt remove mxview

MXview One 1.2.0 User Manual



3. Getting Started

MXview One Control Panel

Server Control

Start the MXview One server on the computer before launching the MXview One web console. On the server
computer, double-click the MXview One desktop shortcut in the Windows operating system. For Ubuntu
users, type in the local host IP address to open the page.

The MXview One Control Panel log in screen appears first and after logging in will direct to the Control
Panel.

MXview One Control Panel

Username

Provide the following login credentials

e Username: The default username is admin.
e Password: The default password is moxa.

1@ MXview One Control Panel @erglsn 2 admin v
‘ Server Control
DB Backup & Restore Service StOPPEd

Plug-in Manager

Centificate m

HTTP port is disabled
HTTPS Port: 500

Database Port; 443

Internal Service Port 1: 8883

Internal Service Port 2: 8882

MXview One 1.2.0 User Manual 10



If it is the first time you log in to the MXview One Control Panel, please change the default password to
enhance security.

Login Notification

We strongly recommend that you change the default password to enhance security.

Configuration

Configure the following port numbers in the Configuration Page:
MXview One Control Panel

Server Control
MXview One Central Manager Server Settings
| Configuration

Enable * Yes v
DB Backup & Restore

Plug-in Manager

Certificates Manage Licenses Through MXview One Yes

Central Manager *

P/Domain Name Port

Server Address *

assword

Authentication * Pa o

Site ID *

MXview One Central Manager Server Settings
e Enable

» Yes: This MXview One site will be managed through MXview One Central Manager. This requires the
below MXview One Central Manager settings to be configured.

» No: The MXview One site operates independently and cannot be managed through MXview One
Central Manager.

¢ Manage Licenses through MXview One Central Manager
> Yes: All the licenses of this MXview One site will be managed through MXview One Central Manager.
» No: The licenses for this site are managed locally at the MXview One site.

e Server Address
> IP/Domain Name: The IP address of MXview One Central Manager.

> Port: The service port used to connect to MXview One Central Manager. The default port number is
8883.

e Authentication
» Password: The password used to connect to MXview One Central Manager.
e SiteID

> Site ID: This value represents the site ID as shown on the Site Management page in MXview One
Central Manager.

MXview One 1.2.0 User Manual 11



Interface Settings

Web Interface

HTTPS *

HTTP*

Database Interface

Port *

Password *

Micreservices Interface (@

Internal Service Port 1 *

Internal Service Port 2 *

¢ Web Interface

500

Enable

Disabled

5432

» HTTPS: Specify the HTTPS port of the MXview One Central Manager server. The default port is 443.
» HTTP: Enable or disable HTTP. If enabled, specify the listening port of the server. The default port is

80.
o Database Interface

» Port: Specify the service port of the MXview One Central Manager database server. The default port

is 5432.

» Password: The password used to connect to MXview One Central Manager.
e Microservices Interface

> Internal Service Port 1/2:

i Port: Specify the communication ports between MXview One and its internal system. The

default ports are 8883 and 8882.
ii. Password: The password used for the microservices interface.

When finished, click Save.

DB Backup & Restore

1. Navigate to DB Backup & Restore on the MXview One Control Panel.

The Database Backup & Restore screen will appear and includes Backup and Restore functions.

MXview One 1.2.0 User Manual
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MXview One Control Panel

Server Control
Configuration Backup Restore
DB Backup & Restore

Plug-in Manager Name *

Certificate

2. Choose the Backup tab to start the process of backing up the database.

3. In the Name field, specify the backup file name.

4. Click Save.

5. The message that the file of the backup database has been stored in the specified directory will be
displayed.

The database has been backed up to

C:\Users\ \AppData\Roaming\moxa\mxview
one\db_backup\20230709_120518

6. When the database has been backed up successfully it will appear in the Historical backups list.

MXview One Control Panel

Server Control

Configuration Backup Restore
| DB Backup & Restore
Plug-in Manager Name * Backup test

Certificate

Historical backups

Version  Name Date Time
i 1 Backup test 20221215 13:23:37
i 11 Backup test2 20221215 13:42:02
[ XXX-20221223 20221223 14:09:09

The system backup file includes the following items:

¢ Topology

e Traffic

e Availability

e Event

e Threshold settings

e Maintenance scheduler settings
e OID items

e Trap items

e System settings

e System Restore

The MXview One system will restore the system configurations from a backup file.

1. Click the Restore Tab.
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@ MXview One Control Panel
Server Control
Canfiguraton

| DB Backup & Restore
@ Al database backups are stored on the MXview One server at c:\uun\_).ppn-u\lloaming\mun\mm one\db_backup rU

Plugrin Manager
You can copy a datsbase to & specific path and then press the refresh button 1o get the latest information.

Cartificate

c

Version  Name Date Teme

O Backup test 2020215 132337

O Backup test? 20221215 134202

O NN 2221223 20021223 140909

() 120 Baclkup test 20230709 120518

2. Choose the backups you want to restore in the table. You can also copy a database to a specific path
and then press the refresh button to get the latest result.

3. Click Restore.
A confirmation screen will appear.

Restore Backup

Are you sure you want to restore this backup?

4. Displaying the restoration process.

Restore Backup
° MXview service has stopped ° Restore Successfully ° MXview service has started

Close

5. Click Close.
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Plugin Manager

Navigate to Plugin Manager on the Control Panel. The Plugin Manager is a tool that can be used to
manage the plugin files. When you discover a new Moxa product that has not been integrated in to the
latest MXview One version, you may not be able to retrieve the product information from MXview One. To
solve this, you can download the plugin file from Moxa’s website, and then upload the file in the Plugin

Manager. After uploading the plugin files, these new models can be supported by MXview One.

The Plugin Manager screen includes the following information:

e  Plug-in file version

e Upload a Plug-in file

e  Supported device model

[@ MXview One Control Panel

Server Control

Conifigpaiatian

DB Backup & Restone

Plug-in Mansger

Certificate

Plug-in Version v1.2.230707

o You can get the latest plug-in file from the Moxa website. [

If you already have the plug-in file, please verify that the checksum of the plug-in file is the same as the checksum on the Moxa website

Upload a plug-in file

Supported Device Model[294)

Modsel

Steps to Upload a Plug-in File:

1. Stop MXview One.

2.

[@ MXview One Control Panel @englisn 2 sdmin v

Server Control

Configuration

DB Backup & Restore

Plug-in Manager

Certificate

@

Service stopped

HTTP port is disabled
HTTPS Port: 500

Database Port: 443

Internal Service Port 1: 8883
Internal Service Port 2: 8882

Download the latest plug-in file from the Moxa website. https://www.moxa.com/en/products/industrial-

network-infrastructure/network-management-software/mxview-one-series#resources
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3. Navigate to the Plugin Manager on the Control Panel.

[@ MXview One Control Panel

Server Control
Plug-in Version v1.2.230707
Configuration
DE Backup & Restore -
© Vou can get the latest plug-in file from the Moxa website. (3
Plug-in Manager If you already have the plug-in file, please verify that the checksum of the plug-in file is the same as the checksum on the Moxa website
Centificate

Upload a plug-in file

Supported Device Model(294)

4. Click the folder (I:I) icon in Select a Plug-in File to upload the file (.zip) from your local machine.

5. Click Upload and if successful, the message below will be displayed.
MXview One will upload the plug-in file and display the supported devices.

Successfully updated

Certificates

From the Certificate page, you can view the certificates used by MXview One. By default, you can view
information for Web certificates. If this MXview One instance is managed through MXview One Central
Manager, an additional MQTT certificate tab will be available.

Web Certificates

On the Web tab, you can view the information for the current web certificates, including:

e Issue To - Common Name (CN)
e Issue By - Common Name (CN)
e Issue By - Organization (O)

e Issued On

e Expires On
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MXview One Control Panel

Server Control

Configuration Web MQTT

DB Backup & Restore

Certificate Information
Plug-in Manager

Issue To - Common Name (CN)
Certificates Mview.One
Issue By - Common Name (CN)
MXview One

Issue By - Organization (0)
Mexa Inc.

Issued On
Tuesday, Jul 19, 2033 at 12:00:00 AM

Expires On
Wednesday, Jul 19, 2023 at 12:00:00 AM

Import Certificate

Private Key (.key) *

CA Certificate (.crt, .cer) *

Regenerating the Certificate

1. Click the Regenerate button.
The Regenerate Certificate window will appear.

Web MQTT

Certificate Information

Issue To - Common Name (CN)
MXview One

Issue By - Common Name (CN)
MXview One

Issue By - Organization (0)
Moxa Inc.

Issued On
Tuesday, Jul 19, 2033 at 12:00:00 AM

Expires On
Wednesday, Jul 19, 2023 at 12:00:00 AM
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2. Click Regenerate to regenerate the certificate.

Regenerate Certificate

A\ Are you sure you want to regenerate the certificate?

The existing certificate will be deleted and a new certificate will be

generated.

3. After successfully regenerating the certificate, MXview One Central Manager Control Panel will need to
be restarted for the certificate to take effect. Click Close and restart the instance.

Restart Required
Please restart MXview One Control Panel and MXview One to

activate the certificate.

Close

Importing a Certificate
You can manually important a certificate file and key file.

1. Click the folder icon for the Private Key and CA Certificate fields and navigate to the certificate
(.crt, .cer) and key (.key) file on the local host.

Import Certificate

Private Key [ key) * Chmxview.key m]

CA Certificate (.crt, .cer) *  CAmxview.crt o

2. Click Import.

3. After successfully importing the certificate, MXview One Control Panel will need to be restarted for the
certificate to take effect. Click Close and restart the instance.

Restart Required
Please restart MXview One Control Panel and MXview One to

activate the certificate.

Close

MQTT Certificates

/7  NOTE

By default, no MQTT certificate will be available. To view MQTT certificate information, import the CA
Certificate generated through MXview One Central Manager. Refer to Importing the MXview One Central
Manager CA Certificate.
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If this MXview One instance is managed through MXview One Central Manager, the MQTT tab will be
available. On the MQTT tab, you can view the information for the current MQTT certificates, including:

e Issue To - Common Name (CN)
e Issue By - Common Name (CN)
e Issue By - Organization (O)

e Issued On

e Expires On

[@ MXview One Control Panel

Server Control

Configuration Web MOTT

DB Backup & Restore

Certificate Information
Plug-in Manager

Issue To - Common Name (CN)
Certificates Mxview One

Issue By - Common Name (CN)
MXview One

Issue By - Organization (0)
Moxa Inc

Issued On
Friday, Jul 15, 2033 at 12:00:00 AM

Expires On
Saturday, Jul 15, 2023 at 12:00:00 AM

Delete CA Cerlificate

Import Certificate

CA Certificate (.crt, .cer) * ]

Importing the MXview One Central Manager CA Certificate

If this MXview One instance is managed through MXview One Central Manager, upload the CA certificate
generated through MXview One Central Manager Control Panel here.

1. Click the folder icon for the CA Certificate field and navigate to the certificate file generated through
MXview One Central Manager Control Panel on the local host.

[@ MXview One Control Panel

Server Control

Configuration Web MaTT

DB Backup & Restore
Bl T Import Certificate

Certificates CA Certificate (.crt, .cer) * D

If the uploaded certificate is not from Central Manager, an error message will appear.

Failed to import the certificate. Please make sure

the certificate is the same as MXview One Central Close
Manager.
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Click Import.

After successfully importing the certificate, MXview One Control Panel will need to be restarted for the
certificate to take effect. Click Close and restart the instance.

Restart Required

Please restart MXview One Control Panel and
MXview One to activate the certificate.

Close

Deleting the CA Certificate
1. Click Delete CA Certificate to delete the current CA certificate file.
The Delete CA Certificate window will appear.

Web MarT

Certificate Information
sue To - Common Name (CN)

MXview One

By

ue By - Common Name (CN)
MXview One

ssue By - Organization (0)
Moxa Inc.

ssued On
Wednesday, June 7, 2023 at 12:00:00 AM

Expires Or
Tuesday, June 7, 2033 at 12:00:00 AM

Delete CA Certificate |

2. When prompted, click Delete.

Delete CA Certificate

A Are you sure you want to delete CA certificate?

Ca”cel

3. After successfully deleting the certificate, MXview One Control Panel will need to be restarted for the
certificate to take effect. Click Close and restart the instance.

The existing certificate will be deleted

Restart Required

Please restart MXview One Control Panel and
MXview One to activate the certificate.

Close

Starting the MXview One Server and Logging
Into MXview One

1. Click Start on the Server Control page. The MXview One server will start running.
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1@ MXview One Control Panel @english & admin ¥

| Server Control

Configuration @

DB Backup & Restore Service StoppEd

Plug-in Manager

Certificate m

HTTP port is disabled
HTTPS Port: 500
Database Port: 443

Internal Service Port 1: 8883
Internal Service Port 2: 8882

2. Wait for the status to display Service is running, then click Open MXview One and log in to MXview
One:

v

Service is running

You are monitoring your network.

Stop Open MXview One

MXview ONE

Username

Password J

MOXAN

Copyright Moxa, Inc. All Rights Reserved.

Provide the following login credentials
» Username: The default username is admin.
» Password: The default password is moxa.

/  NOTE

Alternatively, you can log in to MXview One from a computer located remotely after starting the MXview
One service. For more information, see Logging Into MXview One Remotely.
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Logging Into MXview One Remotely

You can log in remotely to MXview One that is installed on your local site computer from another computer.

1. Launch the MXview One server at the local site computer. Go to the tool bar and click the MXview One

icon. Select Remote Access.

Launch Control Panel
+ Remote Access

Stop and Exit

T4 02:52
2022/6/13

/7  NOTE

If you want to close the remote function, just click Remote Access again, then the function will be closed.

2. Open a web browser on the computer located at the remote site.

3. In the address bar, input the IP address or domain name of the computer that you want to log in to
MXview One from.

> Format: https://[IP address]:[Port]
» Example: https://192.168.1.250:7100
The MXview One Control Panel appears.

MXview One Control Panel

Username

Password [N

4. Provide the following login credentials
» Username: The default username is admin.
» Password: The default password is moxa.
5. You can choose one of the actions listed below:
» Click the Start button
> Click the Stop button
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» Change the configurations on the Configuration page

[@ MXview One Control Panel @englsn & admin v
‘ Server Control
DE acidp: & fremott Service stopped

Plug-in Manager

Cenificate m

HTTP port is disabled
HTTPS Port: 500

Database Port: 443

Internal Service Port 1: 8883
Internal Service Port 2: 8882

6. To open the MXview One web console, you can type the IP address of the computer at the local site into
another web browser once the MXview One Control Panel displays 'Service is running now'.

> Format: https://[IP address]
» Example: https://192.168.1.250
The MXview One web console appears.

7. Provide the following login credentials
» Username: The default username is admin.
» Password: The default password is moxa.

MXview ONE

Username

Password

MOXAN

Copyright Moxa, Inc. All Rights Reserved.

/  NOTE

A maximum of 10 users can log in to MXview One web console at the same time.

License Management

You can monitor your devices inside the networking status via MXview One. Please note, in order to monitor
the devices, you need to activate the Node-based license. For example, if you activate 123 nodes in MXview
One, then during the device discovery MXview One will only recognize up to 123 nodes. MXview One will
stop the device discovery process once it reaches the 123-node limit.
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To increase the node limit, you can purchase additional licenses and import the license into MXview One.

/7  NOTE

Click "Start Trial" to start using MXview One.
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Checking the License

The License Management screen displays information about your MXview One license, including the
number of licensed nodes, nodes currently in use, and application license. You can also use the License
Management screen to add a new license or deactivate an existing license.

To access the License Management screen, navigate to Menu (E) > Administration > License
Management.

License Management

MXview One )
‘ License Wireless Add-on License Power Add-on License
Mode: None Mode: None Mode: None
. State: No valid licenses
Current Nodes: 0
A

Licensed Nodes: 0

Moxa License Site [

Add New License License Type

Free Trial

Start to experience the power of MXview
One

Re-activate License

Use both the Deactivation code and a
User Code to re-activate your license.

Start Trial Re-activate

Adding a New License

To increase the node limit of your MXview One server, you need to add the node-based license.

1. Navigate to Menu (E) > Administration > License Management.
The License Management screen appears.
In the Add New License section, click Add New License.
2. Login to the Moxa License Site to activate the MXview One license. Click Next to get the User Code.

Add New License

o o ©

Log in to the Moxa License Copy User Code Activate
Site

1. Log in to the Moxa License Site [4
2. Choose "Activate a Product License” and "MXview One”" on the site.
3. Registration Code

Your registration code (Type: MXview One NEW)

(Model name: LIC-MXviewOne-NEW-XN-SR) is
XXXXHXOOCOAOCKOCOOOOK XXX
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3. Copy the User Code.

Add New License

Log in to the Moxa License Copy User Code Activate
Site

Copy the User Code to the Moxa License Site [4

-

4. Input a valid activation code.

Add New License

o o ©

Log in to the Moxa License Copy User Code Activate
Site

Download the license from the Moxa License Site, and paste the Activation Code
here.

ctivation Code

Close Apply

5. Click Apply.
MXview One activates the new license.

/  NOTE

Please reference Chapter 4: License Management to get more details on how to get the activation code.
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Using Device Discovery

MXview One provides Device Discovery to help users quickly determine the network topology and handle
basic configuration tasks.

1. To launch Device Discovery manually please do the following:
Navigate to Menu (E) > Device Discovery.
Device Discovery appears to the right of the navigation panel.

Device Discovery

o Network Range(s)

A Scanned range(s) will be saved after device discovery.

p Enabled/Disabled Name First IP Address Last IP Address Group Site Name
[=]

2. Add the IP address ranges to scan for devices.

/7  NOTE

MXview One supports scanning multiple IP address ranges. The selected IP address scan ranges must be
enabled in order for MXview One to scan for devices.

/7  NOTE

Moxa devices must have the SNMP function enabled for MXview One to scan the devices.

Add Scan Range

Enable Scan Range

Enabled »
Name *
IDR Prefix
First IP Address * /24 (255.255.255.0) ~
Last IP Address * CIDR Address Range
roup *
Root b

Cancel

a. Click the Add (&) icon.
The Add Scan Range screen appears.

b. Select one of the following options:
O Enabled: Select to enable scanning of the specified IP address range.
O Disabled: Select to disable scanning of the specified IP address range.
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c. Configure the following:

Provide a custom display Name for the scan range.
Specify the First IP Address of the scan range.

Specify the Last IP Address of the scan range.

Select the CIDR Prefix for the scan range (if applicable).

[ o o |

Select the MXview One Group to assign the scan range to.

Click Add.

(Optional) Add additional network scan ranges, repeat the previous steps.

(Optional) Modify scan range settings, click the Edit (/') icon next to an added scan range.
(Optional) Remove a scan range, click the Delete (i) icon next to the added scan range.

Sa ™o a

Select one or more scan ranges to scan.
i. Click Next.
MXview One scans the specified IP address ranges for devices.

Device Discovery

o Network Range(s) e Disco!

A Scanned range(s) will be saved after device discovery.

2 a Enabled/Disabled Name First IP Address Last IP Address Group Site Name
0 # W Enabled Test 192.168.127.1 192.168.127.254 Root ClaireYHChang-NB

3. View devices discovered on the network.

a. MXview One displays discovered devices on the Discovery Result list. Scroll down to view more
devices on the list.

Device Discovery

o Network Range(s) 9 Discovery Result 9 Complete

Device Alias Device IP Group Site Name

Device discavery successful

3@

b. Click Next.
4. Click Browse Topology to view the detailed network topology.
The Topology screen appears.

Device Discovery

o Network Range(s) o Discovery Result o Complete
0 device(s) added to MXview One

Browse Topology
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/  NOTE

MXview One cannot guarantee that it can draw the link of the topology for non LLDP devices. However,
you can draw the link of the topology manually by clicking Add Link.

Account Management

To launch Account Management, please do the following: Navigate to Menu (E ) > Account

Management.

The Account Management screen allows you to view, add, modify, and delete user accounts from MXview
One. You can also export a list of user accounts and related information as a CSV file.

Account Management

User Account Password Policy

All Users (3)

+]

@

Administrator (1)
Supervisor (0)

< |user(2)

O 0o ojao
N,

Login Netification

Username

admin

user

guest

Authority

Administrator

User

User

Q Search

Accessible Sites

ClaireYHChang-NB

ClaireYHChang-NB

ClaireYHChang-NB

MXview One provides three default accounts:

e admin
e user
e gduest

Default Username

Default Password Authority

admin moxa Administrator
user moxa User
guest moxa User

Each account can be assigned one of the following Authority permissions:

e Administrator: Has full access rights to modify any settings/configurations and can assign authorities

to other accounts.

e Supervisor: Has full access rights to modify any settings/configurations on all pages apart from the
Account Management page.

e User: Has the permissions listed below.

Function |Description

Dashboard

Read-only

Topology

Read-only

Event History

Can do some actions: Export, Filter

Syslog Viewer

Can do some actions: Export, Filter

Inventory Report

Can do some actions: Export

About MXview One

Can check the version

User Manual

Can link to the document

API Documentation

Can link to the document
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Adding User Accounts

1. Navigate to Menu (E) > Administration > Account Management.
The Account Management screen appears.

2. Click the Add () icon in the top right corner of the screen.
The Add user account screen appears.

Add User Account

Username *

Password * Qk
Authority * -
Accessible Sites * -

Cancel

3. Configure the following account details:
» Username: Specify the Username for the account
» Password: Specify the login password (minimum length: 4 characters) for the account
> Authority: Assign the authority permission (Administrator, Supervisor, or User) for the account
> Accessible Sites: Select which site(s) the account can access
4. Click Add.

Modifying User Accounts

1. Navigate to Menu (E) > Administration > Account Management.
The Account Management screen appears.

2. Click the Edit (f) icon in front of the account you want to modify.
The Modify user account screen appears.

Modify User Account

Old Password * o

Password * &

Authority *

Administrator -

Cancel
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3. Modify the following account details:

» Password: Specify the login password (minimum length: 4 characters) for the account

> Authority: Assign the authority permission (Administrator, Supervisor, or User) for the account
4. Click Apply.

Deleting User Accounts

1. Navigate to Menu (E) > Administration > Account Management.
The Account Management screen appears.
(Optional) Select the check box(es) in front of one or more account(s).

Click the Delete (i) icon in front of the account you want to delete, or in the top left corner of the
screen (if multiple accounts are selected).

MXview One deletes the account(s).

Exporting User Accounts

The Account Management screen allows you to export a CSV file containing all user accounts with
corresponding authority permissions and accessible sites.

1. Navigate to Menu (E) > Administration > Account Management.
The Account Management screen appears.

2. Click the Export (E) icon.
&

Export CSV
O

3. Select Export CSV.

Configuring the Password Policy

Use the Password Policy screen to modify the password requirements for user accounts.

1. Navigate to Menu (E) > Administration > Account Management > Password Policy.
The Password Policy screen appears.

Account Management

User Account Password Policy Login Notification

Minimum length (4 - 16) *
4

Password complexity strength check
(] At least one digit (0-9)
(] Mixed upper and lower case letters (A-Z, a-z)
< | At least one special character (~!@#$%"&*-_;:,.<>[{}()
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Specify the minimum password length (between 4 to 16 characters).
Select one or more of the following password complexity requirements:
> At least one digit (0~9)
> Mixed upper and lower case letters (A~Z, a~z)
> At least one special character (~!@#$%"&*-_|;:,.<>[1{}0)

4. Click Save.

MXview One requires all new account passwords to satisfy the modified password policy.

Configuring Login Notifications

Use the Password Policy screen to customize the notifications displayed when users log in to MXview One.

1. Navigate to Menu (E) > Administration > Account Management > Login Notification.
The Login Notification screen appears.

Account Management

User Account Password Policy Login Notification

Show Login Failure Records
4 Show Default Password Notification

Login Message

J

Login Authentication Failure Message

2. To enable the following notification(s), select the corresponding checkbox(es):
> Show Login Failure Records
» Show Default Password Notification

3. To disable the following notification(s), clear the corresponding checkbox(es):
> Show Login Failure Records
> Show Default Password Notification

4. To display a custom login message, type a string (up to 250 characters in length) in the Login
Message field.

5. To display a custom login authentication failure message, type a string (up to 250 characters in length)
in the Login Authentication Failure Message field.

6. Click Save.

MXview One displays the configured login notifications the next time a user logs in.

MXview One 1.2.0 User Manual 32



Changing the Display Language
Use the Language icon screen to customize the notifications displayed when users log in to MXview One.

1. Navigate to Language (C)

The Language screen appears.
2. Select language.

Language

Language

English >

Cancel Apply

3. MXview One supports the following languages:
German (Deutsch)
Japanese (H4:E)
English
Spanish (Espaiiol)
French (Frangais)
Simplified Chinese (f®j{&$3)
Traditional Chinese (BfEH)
4. Click Save.
MXview One updates the display language.

YV V V V VYV VYV V
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4. License Management

License Management Overview

The License Management screen displays information about your MXview One license, including the
license types, the number of licensed nodes, nodes currently in use, and the Add-on license. You can also
use the License Management screen to add a new license or deactivate an existing license.

To access the License Management screen, navigate to Menu (E) > Administration > License
Management.

License Management

MXview One o
t Node License Wireless Add-on License ~ Power Add-on License
Mode: Trial Mode: None Mode: Nane
Currently Used: 3
: Total Number of Licenses: 2000

Moxa License Site [4

Add New License License Type

Trial Remaining Wireless Free Trial Power Free Trial Re-activate License
Start to experience the MXview One Start to experience the MXview One Use bath the Deactivation Code and a
Wireless Add-on Power Add-on User Code to re-activate your license.
days
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License Type

MXview One provides numerous types of licenses. Each license has a specific function.

Trial License You can experience the power of MXview One for 90 days.

Node License Specifies the number of devices that MXview One can monitor in the network.

Wireless Add-on License |Allows users to access additional wireless related functions.

Power Add-on License Allows users to access additional power related functions.

License Type

You can experience the power of MXview One for 90

Trial License days.

Specifies the number of the devices that MXview One

Node License can monitor in the network.

Allows users to access additional wireless related

Wireless Add-on License Fre

Allows users to access additional power related

Power Add-on License P,

Close
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Adding a New License

1. Navigate to Menu (E) > Administration > License Management.
The License Management screen appears.
2. Inthe Add New License section, click Add New License.

License Management

MXview One
(\ License Wireless Add-on License  Power Add-on License
Mode: None Mode: None Mode: None
State: No valid licenses
. Current Nodes: 0
A

Licensed Nodes: 0

Moxa License Site 4

Add New License License Type

The Add New License screen appears.

Add New License

@ (2] ©

Log in to the Moxa License Copy User Code Activate
Site

1. Log in to the Moxa License Site (4
2. Choose "Activate a Product License” and "MXview One" on the site.

3. Registration Code

Your registration code (Type: MXview One NEW)
(Model name: LIC-MXviewOne-NEW-XN-SR) is

OO0

3. Click Next.
4. Copy the User Code and click Next.

Add New License

o (2] ©

Log in to the Moxa License Copy User Code Activate
Site

Copy the User Code to the Moxa License Site (4

o

5. Open a web browser and go to https://license.moxa.com/. Select MXview One and Log in to your
Moxa account.
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6. Click Products and Licenses > Activate a Product License. Then, select MXview One from the
product type list.

Products and Licenses / Activate a Product License

Product Type Please select a product v

Please select a product
sSDC

IEF

IEC

MRC QuickLink
MXview

MX-AOPC UA Server
MX-AOPC UA Logger
MXsecurity

Security Package

7. Input a valid Registration Code and see if the Product Type behind the Registration Code has
displayed correctly of your license.

8. Paste a valid User code from MXview One. Click “I have read and agree to the EULA (End-user License
Agreements)” checkbox. Then click Activate to get the activation code.

Products and Licenses / Activate a Product License

Product Type MXview One v

Registration Code Product Type : MXview One Node_and_Site

User code

() 1 have read and agree fo the EULA (End-user License Agreements)
This is the first activation of the software, you need to read the EULA, and click | know, so that the activation process can be
handled.

MXview ONE

9. Once the process has been successfully completed, a pop-up window will appear to inform you that your
license code has been activated. Click I know to close the window. If the license failed to activate,
enter the correct Registration Code and User code again. If you are still experiencing problems, please
contact Moxa Support.

Message notification

Thank you for purchasing an MXview One product license!
Your license has been activated, we will send you an activation notification
to your mailbox.
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10. Check your email account you used to apply for your moxa account. The activation code will be sent to
this email address.

Dear Customer,

Your MXview One Activation Code

has been activated successf

ully. Visit the License Activation Portal to see more details about your product and license activation code

11. Copy the activation code from the email.
12. In MXview One, paste the activation code into the Activation Code field.

Add New License

o o ©

Log in to the Moxa License Copy User Code Activate
Site

Download the license from the Moxa License Site , and paste the Activation Code
here.

Activation Code

Close

13. Click Apply and then MXview One will activate the new license.

Adding an Add-on License

1. Navigate to Menu (E) > Administration > License Management.
The License Management screen will appear.

License Management

MXview One @
k License Wireless Add-on License ~ Power Add-on License
Mode: Authorized Mode: None Mode: None
Current Nodes: 0
. Licensed Nodes: 3
n

Moxa License Site [

> Add New License License Type
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2. Click Add New License. The Add New License screen will appear.
Add New License

o (2] (3]

Log in to the Moxa License Copy User Code Activati
Site

®

1. Log in to the Moxa License Site 3
2. Choose "Activate a Product License” and "MXview One” on the site.
3. Registration Code

Your registration code (Type: MXview One NEW)
(Model name: LIC-MXviewQOne-NEW-XN-SR) is

XOOCOOOOCOOCOOCOOOOOOOOONXXX
-

3. Click Next.
4. Copy the User Code and click Next.

/7  NOTE

Please activate the Node-based License before activating the Add-on License.

Add New License

© (2] (3

Log in to the Moxa License Copy User Code Activate
Site

Copy the User Code to the Moxa License Site (3

User Code: |E|

- -

5. Open a web browser and go to https://license.moxa.com/. Select MXview One and log in to your Moxa
account.

6. Click Products and Licenses > Activate an add-on or renewal License. Input a valid Add-on
Registration Code and see if the Product Type behind the Registration Code has shown your license
correctly.

Products and Licenses [ Activate an add-on or renewal License

Add-on or Renewal Registration Code Enter your Registration Code Product type :
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7. Paste a valid User code from MXview One. Then, click Activate to get the activation code.

Products and Licenses / Activate an add-on or renewal License

Add-on or Renewal Registration Product type : MXview One Power
Caode )
User code Enter your user code
License Type ADD

8. Once the process has been successfully completed, a pop-up window will appear to inform you that your
license code has been activated. Click I know to close the window. If the license failed to activate,
enter the correct Registration Code and User code again. If you are still experiencing problems, please
contact Moxa Support.

Message notification

Thank you for purchasing an MXview One product license!
Your license has been activated, we will send you an activation notification
to your mailbox.

9. Check the email account you used to apply for your moxa account. The activation code will be sent to
this email address.

Dear Customer,

Your MXview One Activation Code

has been activated successf

ully Visit the License Activation Paortal to see more details about your product and license activation code

10. Copy the activation code from the email.

MXview One 1.2.0 User Manual 40



11. In MXview One, paste the activation code into the Activation Code field.

Add New License

& o o

Log in to the Maxa License Copy User Code Activate
Site

Download the license from the Moxa License Site , and paste the Activation Code
here.

Activation Code

Close

12. Click Apply and MXview One will activate the license.

Deactivating a License

If you want to transfer a license to a different instance of MXview One, the license has to be deactivated
first.
1. Navigate to Menu (E) > Administration > License Management.
The License Management screen appears.
2. Expand the Licenses section.
A list of activated licenses and activation codes appears.
3. Click Deactivate and MXview One will deactivate the license.

License Management

MXview One o
\ License Power Add-on License
Mode: Authorized Mode: Authorized
. Current Nodes: 0
) Licensed Nodes: 6
A

>

— Moxa License Site (4

Add New License License Type

Licenses

License Type: Power Add-on License

Activation Code:
License Start: 2022-06-16 15:15:13

/  NOTE

If you only have one Node-based License with one Add-on License, you will have to deactivate the Add-on
License first, then deactivate the Node-based License next.

If you have more than one Node-based License, it is ok for you to deactivate the Node-based License or
Add-on License without any order.
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Reactivating a Deactivated License

A deactivated license can be reactivated on the current instance of MXview One.

1. Navigate to Menu (E) > Administration > License Management.
The License Management screen appears.

2. Expand the Deactivated Licenses section.
A list of deactivated licenses and deactivation codes will appear.

License Management

MXview One [}
‘ License Power Add-on License
Mode: Authorized Mode: Authorized
Current Nodes: 0
: Licensed Nodes: 6

> | Moxa License Site 4
4 Add New License License Type
Licenses v

Deactivated licenses

Wireless Add-on License
Deactivation Code:

License Start: 2022-06-16 15:07:15

3. Click Re-activate and then click Next.
Copy the deactivation code and click Next.

Re-activate License

(/] (2]

Log In to the Moxa Copy Deactivation Activate
License Site Code

Copy Deactivation Code and paste it on Moxa License Site

Deactivation Code:

5. Open a web browser and go to https://license.moxa.com. Select MXview One and log in using your
Moxa account.

6. Select Products and Licenses and click Transfer a Product License. Then, select MXview One
from the product type list.
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7. Paste the Deactivation Code followed by the New User Code from MXview One. Then, click Product

Transfer.
Products and Licenses / Transfer a Product License
Product Type MXview One 4
Deactivation Code Enter your deactivation code

New User Code Enter your New User Code
Product
Transfer

K3
V4 NOTE

'Reactivating a Deactivated License' and 'Transfer a Deactivated License to another MXview One instance'
are using the same menu here.

If you are implementing 'Reactivating a Deactivated License' on the current instance of MXview One,
please paste the current MXview One User code in the 'New User Code' section.

8. Once the process has been successfully completed, a pop-up window will appear to inform you that your
license code has been deactivated. Click I know to close the window. If the license failed to deactivate,
enter the license key again. If you are still experiencing problems, please contact Moxa Support.

Message notification

Deactivation Success

9. Check the email account you used to apply for your moxa account. The activation code will be sent to
this email address.

Dear Customer,

Your New MXview One Activation Code

ed successfully. You can now start using MXview on this system. Visit the License Activation Portal to see more details about yo

ur product and license activation code.

10. Copy the activation code from the email.
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11. In MXview One, paste the activation code into the Activation Code field.

Re-activate License

/] o (/] o

Log In to the Moxa Copy Deactivation Copy User Code Activate
License Site Code

Download the license from the Moxa License Site , and paste the Activation Code
here.

Activation Code

Close

12. Click Apply and MXview One will reactivate the license.

Transferring a License to a Different Instance
of MXview One

A deactivated license can be transferred to a new instance of MXview One.

1. Navigate to Menu (E) > Administration > License Management.
The License Management page will appear.

2. Expand the Deactivated Licenses section. A list of deactivated licenses and deactivation codes will
appear. Copy the deactivation codes.

License Management

MXview One

License Power Add-on License
Mode: Authorized Mode: Authorized

Current Nodes: 0

Licensed Nodes: 6

> | Moxa License Site 4
d Add New License License Type
Licenses

Deactivated licenses a

Wireless Add-on License
Deactivation Code:

License Start: 2022-06-16 15:07:15

3. Open a web browser and go to https://license.moxa.com. Select MXview One and log in using your
Moxa account.

4. Select Products and Licenses and click Transfer a Product License. Then, select MXview One
from the product type list.
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5. Paste the Deactivation Code and the New User Code from a new installation of MXview One. Then,
click Product Transfer.

Products and Licenses / Transfer a Product License

Product Type MXview One 4
Deactivation Code Enter your deactivation code
New User Code Enter your New User Code

Product
Transfer

/ NOTE

To obtain a new User Code, please visit "Adding a New License”, and follow steps 1 to 4 to obtain and
copy the new User Code.

6. Once the process has been successfully completed, a pop-up window will appear to inform you that your
license code has been deactivated. Click I know to close the window. If the license failed to deactivate,
enter the license key again. If you are still experiencing problems, please contact Moxa Support.

Message notification

Deactivation Success

7. Check the email account you used to apply for your moxa account. The activation code will be sent to
this email address.

Dear Customer,

Your New MXview One Activation Code

ed successfully. You can now start using MXview on this system. Visit the License Activation Portal to see more details about yo

ur product and license activation code.

8. Copy the activation code from the email.
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9. In MXview One, paste the activation code into the Activation Code field.

Re-activate License

/] o (/] o

Log In to the Moxa Copy Deactivation Copy User Code Activate
License Site Code

Download the license from the Moxa License Site , and paste the Activation Code
here.

Activation Code

Close

10. Click Apply and MXview One will reactivate the license.

Quantity of Monitored Devices Exceeds the
Number of Node-based Licenses

When the quantity of monitored devices exceeds the activated number of license nodes, you can purchase
additional Node-based Licenses and activate them as required. Or you can delete the extra devices that you
don't have to monitor.

License Management

MXview One
N\ License Wireless Add-on License
Mode: Authorized Mode: Trial
State: Not enough nodes fo Mview One will be locked after 30 please purchase additional nodes
D e zon A R

usage limit.
Licensed Nodes: 2000 =

Moxa License Site [

Add New License License Type

Licenses

Wireless Trial Remaining Re-activate License

58

days

Use both the Deactivation Code and a
User Code to re-activate your license.

1. Buy Extra Node-based Licenses
Order the required quantity of Node-based Licenses from your channel or Moxa Sales Representative.
Then, follow the instructions on Adding a New License to activate a new license.

2. Delete Extra Devices

a. You can delete the devices on the Topology page to meet the number of Node-based Licenses you
available.
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b. Please follow the instructions below:
O Press the Stop button in the Control Panel.

v

Service is running

You are monitoring your network.
m Open MXview One

O After 1 minute, Click Start and wait for the status to display 'Service is running now'. Then,
click Open MXview One and Log in to MXview One.

O Navigate to Menu (E) > Topology.
The Topology screen will appear and displays the Topology Map by default.

O Click the devices you want to delete and then click Delete. From now on, MXview One will not
count the delete devices.
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5. Dashboard Widgets

The MXview One Dashboard contains several widgets that provide summary information about your
network devices and event highlights.

Dashboard Overview

To access the Dashboard, navigate to Menu (E) > Dashboard.
Use the Dashboard to gain a quick overview of your network devices, important system events.
The Dashboard displays the following widgets:

e Device Summary

e Event Highlights: Cold/Warm Start Trap
e Event Highlights: ICMP Unreachable

e Event Highlights: Link Down

To refresh the data displayed in all the widgets, click the Settings ( { ) icon in the top right corner of the
screen and select Refresh All.

Device Summary

The Device Summary widget displays the following information about the devices on your network:

Device Summary

022-12-1410:51:24 (3

3 0

Healthy Devices Warning Devices Critical Devices

View Network Topology.

)

¢ Healthy Devices: The number of devices with no critical events or warnings.
Click to view additional details about the devices on the Topology screen.

e Warning Devices: The number of devices with warnings.
Click to view additional details about the devices on the Topology screen.

e Critical Devices: The number of devices with critical events.
Click to view additional details about the devices on the Topology screen.

MXview One 1.2.0 User Manual 48



Event Highlights

The Event Highlights will display the following events during the past seven days: Cold/Warm Start Trap,
ICMP Unreachable, and Link Down.

Event Highlights Last Update: 20221214 10:53:24 (3

20

Count

12108 12109 12710 12M 1212 12/13 1214
B Cold/Warm Start Trap ICMP Unreachahble Link Down

Event Highlights: The Cold/Warm Start Trap widget displays the number of cold start traps and warm
start traps issued by devices at a site, and the day on which the events occurred.

Event Highlights: The ICMP Unreachable widget displays the number of times an ICMP-enabled device
on your network was unreachable, and the day on which the events occurred.

Event Highlights: The Link Down widget displays the number of times a port link was down on a device
on a specific date.

You can perform the following actions on this widget:

To view the number of event highlights issued at a site on a specific date, hover over a bar in the
widget chart.

To view additional details about the event on the Event History screen, click a bar on the widget chart.
To refresh the widget data, click the Refresh (C) button following the Last Update timestamp.
To download the Event Highlights data, click (=) below the Refresh button.
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6. Device Discovery and Polling

Device Discovery Overview

MXview One uses SNMP, ICMP, and MMS to discover devices within the scan ranges. When a Moxa device

has been located, MXview One will generate an actual image of the device, demonstrated below, to indicate

the device’s location on the network.

MXview One will also list detailed properties and configuration parameters, including the following:

e MAC Address

e Model Name

e IP Address

e Netmask

o Gateway

e Trap Server Address

e Auto IP Configuration

e Type of Redundancy Protocol

e Role in Redundancy Protocol

e  Status and Properties of the Port
e Power Status

e Status and Version of the SNMP Protocol

MXview One will display one of the following graphics to indicate devices:

BOXA

Moxa devices with SNMP enabled.

Non-Moxa devices with SNMP enabled. l m

Non-Moxa devices with ICMP enabled. l m]

Non-Moxa devices with MMS enabled.
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Configuring IP Address Scan Ranges

MXview One allows you to scan multiple ranges of IP addresses within your network. Each network range is

defined by a starting IP address and an ending IP address. Use Device Discovery to configure network

scan ranges.

1. Access the Device Discovery screen by the following method:
a. Navigate to Menu (E) > Device Discovery.

b. Navigate to Menu (E) > Topology, and then navigate to Topology > Device Discovery from the

Topology toolbar menu.

A Topology v e G

Q_ Device Discovery

Auto Topology

>

Auto Layout

e

The Device Discovery screen will appear.

° Network Range(s) ° Discovery Result

A The scanned range(s) will be saved after the device has been discovered.

<
O Enabled/Disabled Name First IP Address Last IP Address Group
O o W Enabled Test 192.168.127.1 192.168.127.254  Root

2. To add a new scan range:
a. Click the Add () button in the top left corner.
The Add Scan Range screen will appear.

Add Scan Range

Enable Scan Range

Enabled -

Name *

CIDR Prefix
First IP Address * /24 (255.255.255.0) ~

Last IP Address * CIDR Address Range

Root -

Cancel

e Complete

Site Name

Site BRANDON

»
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b. Select the scan range status:

O Enabled

O Disabled

Provide a Name for the scan range.

Provide the starting IP address for the scan range.
Provide the ending IP address for the scan range.

Select the CIDR Prefix (if applicable).

Assign the scan range to a Group.

Click Add.

The new scan range appears in the Network Range table.

T@a ™o a o

To edit a scan range:
Select the check box next to the scan range in the Network Range table.
Click the Edit (") icon.
The Edit Scan Range screen appears.
Modify the scan range settings.
Click Apply.

The Device Discovery screen displays the Network Range table with the updated scan range
information.

Click Next to discover the devices within the specific IP address ranges.

a Network Range(s) 9 Discovery Result e Complete

Device Alias Device IP Group Site Name

Device discovery is finished 0of0

To complete scan range configuration, click Next.

s

I

The Complete tab and the number of devices added to MXview One.

o Network Range(s) o Discovery Result o Complete

There are 0 device(s) added to MXview One

|—=" Browse Topology

<

_J

To view the updated topology, click Browse Topology.
The Topology screen will appear and display the updated Topology Map.
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Configuring Device Polling Settings

Devices in the assigned scan range can be discovered via SNMP and ICMP protocols. (The default polling
interval of ICMP is 10 seconds, while SNMP is 60 seconds. Users can go to the Device Settings Template
page to change the polling intervals.) After a device is discovered, MXview One will use SNMP and ICMP to
poll the device periodically. To configure this function properly, you will need to know the following
information:

/7  NOTE

MXview One Dashboard widgets also use the device polling settings. For more information about the
MXview One Dashboard widgets, see Chapter 5: Dashboard Overview.

1. Navigate to Menu (E) > Administration > Device Settings Template.
The Device Settings Template screen appears.
2. Scroll down to the Polling Settings section.

Polling Settings

10
60

3. Configure the following ICMP polling settings:

ICMP polling interval: Specify the time in seconds between polls. MXview One will use ICMP protocol
to check if the device is alive.

4. Configure the following SNMP polling settings:
SNMP polling interval: Specify the time in seconds between polls.

5. Scroll down to the Log In section to configure the device web console login credentials:
> Username: The login username for the device web console
» Password: The login password for the device web console

6. Click Save.

MXview One will update the modified settings.
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Changing Default SNMP Configuration

The default SNMP read community string that is used to discover devices is public. Use the Device Settings
Template screen to change the default read community string or modify other default SNMP configuration.

1. Navigate to Menu (E) > Administration > Device Settings Template.
The Device Settings Template screen will appear.
2. Scroll down to the SNMP Configuration section.

SNMP Configuration

Vi v 161

< public private

3. Configure the following:

SNMP Version: Select the SNMP protocol version
SNMP Port: Specify the SNMP port

Username: Specify the SNMP server username
Password: Specify the SNMP server password

Read Community: Specify the new community string
Write Community: Specify the new community string

@ ™o a o T o

Data Encryption: Select the data encryption method
O NoAuth
3  AuthNoPriv
3O  AuthPriv
h. Authentication: Select the authentication method
dJ MD5
O SHA
3O SHA256
0 SHA512
i. Encryption Protocol: Select the encryption protocol and input the Encryption Password.
d DES
d AES
4. Click Save.
MXview One updates the modified settings.

Changing Modbus TCP Settings

By configuring Modbus TCP Settings in the Device Settings Template section, MXview One will be able to
detect whether a device has Modbus attributes or not. If a device supports Modbus, a Modbus string will
appear above the device icon in the topology to easily identify the device.
1. Navigate to Menu (E) > Administration > Device Settings Template.

The Device Settings Template screen will appear.
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2. Scroll down to the Modbus TCP Settings section.

Modbus TCP Settings
Disabled ¥
port
502

3. Configure the following:
a. Enabled: Enable or disabled Modbus TCP settings
O Enabled
O Disabled
b. Port: Specify the Modbus TCP port
4. Click Save.
MXview One updates the modified settings.
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7. Topology Management

MXview One allows you to view a graphical representation of your network topology, add/delete devices and
links to the Topology Map, organize the topology structure, and export the Topology Map as a PNG image.
You can also scan specific IP address ranges to discover devices on your network.

Topology Overview

The Topology screen allows you to view the Topology Map, which is a graphical representation of the
devices in your network, and perform most actions in MXview One. For example, you can use the Network
Topology screen to do the following:

e Display a graphical representation of a real network.

e Show connecting relationships between devices.

e Indicate the status of devices and links.

All > Site BRANDONYANG-PC > Root

A Topology v @ Growp v /' Edit v @ Visualization v aZSFP v

Q
192.168.127.114 g
192.168.127.93
. m
>
]
a
192.168.127.104 1921681271- 168.127.115
2
a Y-
4 »
[J Always show "Recent Events” at startup
= T @ Q Search
(m] Site Name D Source  Source IP Device Alias Description Time Issued
Mxview
0o e B  Ssite BRANDONYANG-PC 180 192.168.127.169  192.168.127.169-AWK-4131A Device SNMP reachable 2022-05-12 17:09:27

One
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Viewing Topology Map
Use the Topology screen to view the Topology Map of your network.

1. Navigate to Menu (E) > Topology.
The Topology screen will appear and displays the Topology Map by default.
2. If the List view is displayed, click the Topology view ( *) icon in the top right corner.

The Topology screen will display a graphical representation of the devices and links on your network.

3. To search for a specific device on the Topology Map:
a. Click the Search topology (2 ) icon in the top left corner.
The topology search box appears with a drop-down directory tree of the Topology Map structure.

Search topology

Q

Root

CC:30:80:3C:75:1C

192.168.127.252-EDS-505A
00:90:E8:7D:AB:23

‘ 192.168.127.253-EDS-508A
00:90:E8:80:2B:6B

b. Search the device in the drop-down directory tree or type a string in the search box. Click the
specific device and MXview One will bring you to the device on the Topology Map.

I 192.168.127.1--ICMP Device

4. To view the details of a specific device, select the device in the Topology Map.

- a

192.168.127.252 H 4]
EDS-505A

Ring 1 Master

192.168.127.253
EDS-508A

The Device Properties pane appears to the right of the Topology Map.

Device Properties Current Status

Basic Device Properties

Alias
EDS-510E

Model Name
EDS-510E

MAC Address
00:90:E8:86:2F:16

Availability
100.00%

System Description
EDS-510E-3GTXSFP

System Object ID
.1.3.6.1.4.1.8691.7.84
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5. To view events associated with the device, click the Current Status.
The Current Status pane displays events associated with the device.

Device Properties Current Status

No events

6. To view details about a link between devices, select a link in your Topology Map.

Ring 1 Master
. — = —
192.168.127.252 192.168.127.253
EDS-505A EDS-508A

The Link Properties pane appears to the right of the Topology Map.

Link Properties

Link Information

From
10.81.10.12

Port 9

To
10.81.10.13

Port 8

Link Speed
1Gb

SFP Information

From
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Viewing Recent Events

Use the Topology screen to view recent events from devices in your topology. You can filter the

the list or export the data as a CSV file.

For more information on viewing all events, see Chapter 10: Event Monitoring.

1. Navigate to Menu (E) > Topology.

The Topology screen will appear and displays the Recent Events panel on the bottom.

All > Site BRANDONYANG-PC > Root

X Topology v @ Gropv S Edty @ Visualization v

Ring Master Ring Master

192168.127.13  192.168.127.67_192.168.127.95

[ Always show "Recent

<]

v
oo ofE

1

o ol o e o e o s e R

lo©ol©ol0|0o|o|o|0o|o 0|0 |00 |0 o |0 |0
NENBNNENEBRENEBNEENDR
PrPPPCPrPEPCPEEREDOEECDD

|

Events’ at startup

site Name
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC

Site BRANDONYANG-PC

Ring 1 Master

aSPy T Wirless v

RingMaster  Ring Master

Ring 2 Master
Ring 1 Master

L o

12180258 s iz0s i1z dopissIze wies) RIS 21681210

1754
1753
1752
1751
1750
1749
1748
1747
1746
1745
1744
1743
1742
1741
1740
1739
1738

Source Source 1P

Device Alias

Mxview One  192.168.127.168  102.168.127.168-AWK-1131A

MXview One  192.168.127.168 102.168.127.168-AWK-1131A

Mxview One  192.168.127.168  102.168.127.168-AWK-1131A

Mxview One  192.168.127.168  192.168.127.1

AWK-1131A

Mxview One  192.168.127.168  102.168.127.168-AWK-1131A

Mxview One  192.168.127.168  192.168.127.168-AWK-1131A

Mxview One

Mxview One  192.168.127.168 192.168.127.168-AWK-1131A

MXview One  192.168.127.168  102.168.127.168-AWK-1131A

Mxview One 192.168.127.168  192.168.127.168-AWK-1131A

MXview One  192.168.127.168 102.168.127.168-AWK-1131A

Mxview One  192.168.127.168  192.168.127.168-AWK-1131A

MXview One  192.168.127.168 102.168.127.168-AWK-1131A

Mxview One  192.168.127.168  102.168.127.168-AWK-1131A

MXview One  192.168.127.168 102.168.127.168-AWK1131A

Mxview One  192.168.127.160  102.168.127.160-AWK-4131A

Mxview One  192.168.127.169 102.168.127.160-AWK-4131A

Q searct

events in

BRI

Description

Device SNMP reachable
Device SNMP unreachable
Device SNMP reachable
Device SNMP unreachable
Device SNMP reachable
Device SNMP unreachable
User login: admin

Device SNMP reachable
Device SNMP unreachable
Device SNMP reachable
Device SNMP unreachable
Device SNMP reachable
Device SNMP unreachable
Device SNMP reachable
Device SNMP unreachable
Device SNMP reachable

Device SNMP unreachable

Time Issued

20220428 13:48:34
20220428 13:48:28
20220428 133818
20220428 1338:08
20220428 1322:12
20220428 1322:04
20220428 13:16:52
20220428 1301:53
20220428 13:01:45
20220428 12:53:20
20220428 1253:15
20220428 12:32:32
20220428 1232:23
20220428 1221:28
20220428 1221:23
20220428 12119:52

20220428 12:19:44

2. To filter the information in the table, type a full or partial string that matches the value in any of the
table columns on the right of the search space.

MXview One filters the table to only display events with values that fully or partially match the specified

string.

3. To filter the information in the table by specific criteria:

a. Click the Filter (=) icon below the Recent Events tab.

The criteria selection screen appears.

= o

Severity

Source

Group

IP Address

b. Specify any of the following criteria:

Reset Apply

O Severity: Select the event severity level

>

YV V VYV VYV

Any
Information
Warning
Critical

System Information
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O Source: Select the source that detected the event
» Any
» MXview One
» Trap
» Security Sensing
O Group: Select the device group
O IP Address: Select the device IP address
c. Click Apply.
MXview One filters the table to only display events that match the specified criteria.
4. To acknowledge the events in the table:
a. Click the Acknowledge (B8) icon before the specific event, then the event will be confirmed.

b. If you want to acknowledge more events, click the checkbox before the events or click the checkbox
on the tool bar to select all the events. Then, click the Acknowledge icon.

5. To sort the data in the table by a specific column, click the column heading.
MXview One sorts the table by the column.

ID Source Source I Device Alias

43 g"f;'e“" 102.168.127.252 192.168.127.252-EDS-505A

6. To export data displayed in the Recent Events tab:

a. Click the Export (E]) icon.
= = @

D Export CSV N

O 9 t

b. Select Export CSV.
c. Specify the location to save the exported file.
d. Click Save.
MXview One exports the displayed event data as a CSV file.

7. To quickly filter event, click the Quick filter event (:==) icon to find the events.

The events include the following:

» Unacknowledged Events

» Last 20 Unacknowledged Events
» Last 20 Events

» Last 50 Events.

== @

Unacknowledged Events

Last 20 Unacknowledged Events

Last 20 Events

Last 50 Events
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8. MXview One allows users to display the Recent Events panel all the time by clicking the Always show

"Recent Events" at the startup checkbox.

[] Always show "Recent Events” at startup

= = @

O Site Name

Organizing the Topology Structure By Group
Function

The Topology Map can be organized into a multi-layer tree structure of up to 5 layers. Organizing the
topology structure into groups helps manage a large number of nodes on the computer screen. For
example, users can move nodes of the same subnet or location into the same group. Root, which is the only

group at the first layer, exists by default and cannot be deleted. Groups created by users are in the layer
under Root. Devices can be moved between groups.

1. Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.
» MXview One represents the Topology Map structure by a path at the top of the Topology screen:

All > Site BRANDONYANG-PC > Root »
J\ Topology v e Group v /’ Edit v

» If the Topology Map contains groups under the Root layer, you can click the right arrow (>) and
select the group:

All > Site BRANDONYANG-PC > Root

A Topology v 0 Group v /’ |

v

group 1

(@]

» You can also click the following icon used to indicate user-defined groups within the Topology Map:

Group1
2. If List view is displayed, click the Topology view ( <) icon in the top right corner.
The Topology screen displays the following toolbar above the Topology Map:

o Topology w & Growp v # Edit~ @ Visualization v
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3. To create a group:
a. Navigate to Group > Create Group.
The Create Group screen appears.

Create Group

Root v

group

Test

Image

The maximum image sizeis 1 MB

b. Configure the following:
O Parent Group
O Group Name
O Group Description
O Group Icon
c. Click Create.
MXview One will add the group below to the specified parent group.
4. To reorganize the groups within the Topology Map structure:
a. Navigate to Group > Group Maintenance.
The Group Maintenance screen appears.

Group Maintenance

¥ Root

group 1

Cancel
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b. Select a layer to modify.
The group details appear to the

Group Maintenance
[ ]

¥ Root

group 1

right of the topology directory tree.

Group Name *

group 1

Group Description

Image B

The maximum image size is TMB

Cancel Apply

c. (Optional) Edit the group details or perform one of the following points:

i (Optional) Click Add to add a new group below the selected layer.

ii. (Optional) Click Delete to remove a group from the topology structure.

d. Click Apply.

5. To reassign the device(s) in a group:

a. There are two ways to reassign the device(s) in a group:

i Navigate to Group > Change Group. The Change Group screen appears.

ii. Select the device(s) you want to reassign on the topology and click the Change Group icon on

the toolbar.

Change Group

Root -

IP Address
192.168.127.154

192.168.127.155
192.168.127.156
192.168.127.157
192.168.127.158
192.168.127.159
192.168.127.160

192.168.127.161

000 |00 |00 |0 O

102 168 127 142

0 Selected / 50 total

group 1 -

Cancel
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b. If the IP Address list does not display the IP address(es) of the device(s) you want to reassign,
select the Current Group drop-down list.

Select the IP address(es) of the device(s) that you want to reassign to a different group.
From the Assign to Group drop-down list, select the new group for the selected device(s).
e. Click Apply.

Redundant Topologies

Redundant topologies have at least one backup link, which will be indicated with a dashed line:

Tail

T = (il o a @ i

182168 127.52 18216812755 18216812756 182 168727 58
5 a g8
2]
182.168.127.51
[ 4 H a 5]
Head Ring 1 Master Raoot
. B HSe=r=n - i3 2 ‘ <] o
182,166 127 50 182 168.127.54 182 168.127.53 182 16B127.57 192168127 .59

For devices that play a particular role in the topology, MXview One will label the devices by displaying the
roles above the images of the devices. Backup links will be indicated with dashed lines.

e RSTP has a Root

e Turbo Ring has a Master

e Turbo Chain has a Head and a Tail

e Dual Homing

NOTE

Only the Auto Topology function can draw dashed lines for redundancy links. Redundant links that are
added manually will appear as solid lines.

PoE

Power Consumption Visualization

By periodic polling, a PoE link will display the port number, power (watts), voltage (V), and current (mA)
directly on the topology map.

192.168.127.75 port 6 l I
E i 3W / 45V / B1mA

e

192.168.127.75 192.168.127.16
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VPN Tunnel Visualization

The VPN tunnel link will display 'VPN' on the link.

1. The VPN tunnel is connected.

‘ 192.168.128.198/T2 VPN 192.168.127.198/T1
192.168.128.199 192.168.127.13

2. The VPN tunnel is disconnected.

192.168.128.198/T2 VPN

92.168.127.198/T1

192.168.128.199 192.168.127.13

7

NOTE

VPN Tunnel Visualization is only available on Moxa’s EDR-810 and EDR-G9010 series of secure routers.

Port Trunking

Port trunking, also called link aggregation, involves grouping links into a link aggregation group. Trunking
links will be indicated with thick, solid lines.

192.168.127.105 162.168.127.107

NOTE

Only Auto Topology can draw thick lines for trunking links. Trunking links that are added manually will
appear as solid lines.

NOTE

For trunked link, check Device Properties to get the port number corresponding to the trunking
information.

CUICHIIELLSHIauu JCUICIHNICL FUIL 274

interface.29

m up / 200M / Full-duplex

ethernetCsmacd /Ethernet Trunking

192.168.127.105 192.168.127.107 Port 1 of EtherDevice Switch
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Adding Devices and Links

MXview One allows you to manually add devices and links to an automatically generated Topology Map. The

Topology screen allows you to add devices from Topology View or List View.
For information about List View, see Chapter 10: Device Management > Viewing the Device List.

1. Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.
2. To add a device to the Topology Map:
a. Click Edit > Add Device.
The Add Device screen will appear.

Add Device

V1

public

161

private

b. Configure the following:
O IP Address: Specify the IP address of the device

Qoo oooaooaoa

c. Click Add.

MXview One adds the device to the topology.

Assign Model: Select the model of the device

Username: Specify the device login Username
Password: Specify the password

Cancel

Assign to Group: Select the group to assign the device to
SNMP Version: Select the SNMP version
Port: Specify the port number

Read Community: Specify the SNMP read community string
Write Community: Specify the SNMP write community string
Data Encryption: Select the data encryption method
Authentication: Select the authentication method
Encryption Protocol: Select the encryption protocol and input the Encryption Password
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3. To add a link to the Topology Map:
a. Navigate to Edit > Add Link.
The Add Link screen will appear.

Add Link

From

To

Cancel

b. Configure the following information for the two devices joined by the link:
O Device: Specify the IP address of the device
O Port: Specify the device port number

c. Click Add.
MXview One adds the link between the specified devices.

NOTE

Links drawn between two devices in the Topology Map are bidirectional. You may specify either device as
the From device or the To device.

NOTE

Trunking and redundancy links added manually will appear as solid lines.

NOTE

Port numbers must be numeric and entered correctly to obtain the correct traffic information.

NOTE

For modular switches, a port number depends on the chassis to which the port belongs, but not on how
many modules are inserted. For switches such as the PT-7828, the first module’s port numbers are from 1
to 8, the second module’s port numbers are from 9 to 16, and so on. The port number depends only on
which slot the module is in; in other words, the port number is the same regardless of whether other slots
are empty or occupied.
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Deleting Devices and Links

You can delete devices and links from the Topology Map. After a device is deleted, it will be removed from
the topology map, and the device will not be polled or located when performing Device Discovery. Deleting a
link will delete a link from the topology map, but it will not affect the actual network configuration.

1. Navigate to Menu (E) > Topology.
The Topology screen will appear and display the Topology Map by default.
2. To delete a device from the Topology Map:
a. Select the device.
The following toolbar menu will appear.

\\ Maintenance v * Tools v /' Change Group C Refresh GD Add Link

b. Click Delete.
A confirmation screen will appear.

Delete Device

Are you sure you want to delete this device?

Cancel
c. Click Delete.

MXview One deletes the device from the Topology Map.
3. To delete a link from the Topology Map:
a. Select the link.
The following toolbar menu will appear.

@ Link Traffic v X Severity Threshold B Set Port Label E Delete

b. Click Delete.

A confirmation screen will appear.

Delete Link

Are you sure you want to delete this link?

Cancel

c. Click Delete.
MXview One deletes the link from the Topology Map.

Updating the Topology Map

Updating the existing topology adds new links and updates existing links, but does not change the status of

links that are indicated as having been disconnected or links that were drawn manually.

For devices with LLDP functionality, MXview One can draw the physical topology map, down to the port level
of the devices. For devices without an LLDP MIB, MXview One is able to draw links by using ARP. To activate
this function, select the Advanced Topology Analysis checkbox from the Auto Topology screen.

1. Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.
2. If List view is selected, click the Topology view (*) icon in the top right corner.

The Topology screen displays a graphical representation of the devices and links on your network.
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3. Navigate to Topology > Auto Topology.
The Auto Topology screen appears.

Auto Topology

(O New Topology

Existing links are going to be deleted

(® Update Topology

Existing links will be kept while new links are added

Advanced Topology Analysis o
[ Strict Link Verification Mode @

*Additional time is required.

(Optional) Select Advanced Topology Analysis to draw links for devices without an LLDP MIB.

Select Update Topology.

(Optional) Select Strict Link Verification Mode. If enabled, links between devices will only be shown
on the topology if the devices on both ends have the other device's information in their LLDP table.

7. Click Apply.
MXview One will update the Topology Map.

/  NOTE

MXview One cannot guarantee that it can draw the link of the topology for non LLDP devices. However,
you can draw the link of the topology manually by clicking Add Link.

Refreshing the Topology Layout

After changes have been made, use the Auto Layout feature to refresh the layout of the Topology Map.
Auto Layout does not update any devices or links. It only redraws the topology to better fit the screen.
1. Navigate to Menu (E) > Topology.

The Topology screen will appear and displays the Topology Map by default.
2. If List view is selected, click the Topology view (%) icon in the top right corner.

The Topology screen will display a graphical representation of the devices and links on your network.
3. Navigate to Topology > Auto Layout.

The Auto Layout screen appears.

Auto Layout

Are you sure you want to use Auto Layout?
(current layout will be overridden)

Cancel m
4. Click Apply.

MXview One refreshes the Topology Map layout.
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Creating a New Topology Map

Creating a new topology deletes all links, requests LLDP information from devices, and draws topology maps
based on the gathered information.

For devices with LLDP functionality, MXview One can draw the physical topology map, down to the port level
of the devices. For devices without an LLDP MIB, MXview One is able to draw links by using ARP. To activate
this function, select the Advanced Topology Analysis checkbox from the Auto Topology screen.

NOTE

Links drawn manually will also be deleted by this action.

NOTE

Your devices must have firmware version 3.1 or higher to use Advanced Topology Analysis.

NOTE

If the Auto Topology function does not create an accurate representation of the actual network, deselect
the Advanced Topology Analysis check box and try again.

1. Navigate to Menu (E) > Topology.

The Topology screen appears and displays the Topology Map by default.
2. If List view is selected, click the Topology view () icon in the top right corner.

The Topology screen displays a graphical representation of the devices and links on your network.
3. Navigate to Topology > Auto Topology.

The Auto Topology screen appears.

Auto Topology

@ New Topology

Existing links are going to be deleted

O Update Topology

Existing links will be kept while new links are added

Advanced Topology Analysis o
[ Strict Link Verification Mode (@)

*Additional time is required.

(Optional) Select Advanced Topology Analysis to draw links for devices without an LLDP MIB.

Select New Topology.

Click Apply.
MXview One will create a new Topology Map.
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/  NOTE

MXview One cannot guarantee that it can draw the link of the topology for non LLDP devices. However,

you can draw the link of the topology manually by clicking Add Link.

Setting/Editing the Background Image

MXview One allows you to customize the Topology Map by uploading a background image in JPG, GIF, or

PNG format.

1. Navigate to Menu (E) > Topology.
The Topology screen appears and will display the Topology Map by default.

2. If List view is selected, click the Topology view ( *) icon in the top right corner.
The Topology screen will display a graphical representation of the devices and links on your network.

3. Navigate to Edit > Background.
The Background screen appears.

Background

Preview (Topology Size: 2265 x 2771)

MOXAN:

I

4. Upload the background image by using one of the following methods:
» The image size must be less than 20 MB.
» Click Set Background (B) icon to upload the image file.
MXview One will set the uploaded image as the Topology Map background.

Background Color

[ #FFFFFF

Image
7 MOXA

Position

0 0

700 136 H

Alpha
e e ]

Saturation @

5. Use the sliders to modify the Alpha and Saturation value of a background image.
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6. Under the Position section, modify the value of X and Y to move the origin of the image to a suitable
location. Modify the 'Width' and 'Height' to change the size of the image.

Background
Preview (Topology Size: 2265 x 2771) Background Color
[] #FFFFFF
E Image

i MOXA

Position
0 0
700 136

Alpha @

I[EU ~| Saturation
— @

7. To delete a background image, click (i) to remove the background image from the Topology Map.

Editing the Topology Appearance

Use the Preferences screen to modify how the Topology Map displays the topology line style, PoE status,
background color, link status, and traffic load.

1. Navigate to Menu (E) > Administration > Preferences..
The Preferences screen appears.

2. In the Appearance section, expand Topology.
The Topology settings appear.

Preferences

Q Search

Appearance

¢ | Topology

opology Line Style

Directed Line Style -

Directed Line Style Elbow Line Style
Text Size

Small v
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3. To modify the Topology Line Style, select one of the following from the drop-down list:

Topology Line Style

Directed Line Style v

PR T—

|
ey

B Directed Line Style Elbow Line Style

> Directed Line Style

MXview One applies the following style to the lines indicating the links between devices in the
Topology Map:

Directed Line Style'

> Elbow Line Style

MXview One applies the following style to the lines indicating the links between devices in the
Topology Map:

Elbow Line Style.

4. To modify the text size in MXview One:
Select one of the following from the drop-down list:
» Large
» Medium
» Small

Text Size
Text Size

Small -
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5. To modify how MXview One displays Power-over-Ethernet (PoE) links:

a. Select the Show PoE Status on Topology check box to indicate the PoE link status on the
Topology Map.

PoE

Show PoE Status on Topology
PoE Link Colorf | #CECECE

b. Click the PoE Link Color field and specify a new color.
PoE

Show PoE Status on Topology
PoE Link Colof{ ] #CECECE 25

Background

Background Color| | #FFFFFF

Status Color

Link Up Link Down

[[] #Ccecece W #Froc @ T .

Turbo Ring V1 Turbo Ring

[[] #CECECE ] #cec #oecece s
Hex

Turbo Chain RSTP

c. (Optional) Clear the Show PoE Status on Topology check box to hide the PoE link status on the
Topology Map.

PoE

[[] Show PoE Status on Topology
PoE Link Color] | #CECECE

6. To modify the Topology Map background, click the Background Color field and specify a new color.

Background

o
Background Colofl | #FFFFFF b

Status Color

Link Up Link Down
[[] #CECECE I #FrFoo00

Turbo Ring V1 Turbo Ring V2

[ ] #CECECE | ] #CECECE

Turbo Chain RSTP

[] #CECECE [] #CECECE | i v
PRP LAN A PRP LAN B Hex
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7. To modify the color used to indicate the status of specific links in the Topology Map, click to modify the

Status Color hex code for any of the following links:
Link Up

Link Down

Turbo Ring V1

Turbo Ring V2

Turbo Chain

RSTP

PRP/Coupling LAN A

PRP/Coupling LAN B

HSR Ring

YV V V V VYV V V VYV V

Status Color

Link Up Link Down
[ ] #CECECE B #FFoo00
Turbo Ring V1 Turbo Ring V2
[ ] #CECECE [ ] #CECECE
Turbo Chain RSTP
[] #CECECE [] #CECECE
PRP LAN A PRP LANB
I #008000 I #0000FF
HSR Ring
I #800080
\g
/  NOTE

The three status colors (PRP LAN A, PRP LAN B, HSR Ring) will appear when you activate the MXview
Power license.

8. Click Save.
MXview One will update the modified settings.
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Editing the Device Appearance

Use the Preferences screen to modify how devices appear in the Topology Map.

1. Navigate to Menu (E) > Administration > Preferences.
The Preferences screen will appear.

2. In the Appearance section, expand Device.
The Device settings will appear.

Appearance
Topology v
Device &

o Preview
<
IP Address

Bottom Labe
Naone v

A If you change the Alias setting, please delete the device on the topology and
then rescan or add a device to complete the 'Alias’ setting.

Alias
Bottom Labe + Bottom Labe
IP Address v Model Name -

3. To modify the label that indicates the device in the Topology Map:
a. Locate the Bottom Label drop-down list located below the Preview image:

Device

Preview

IP Address

Bottom Label

None -

A If you change the Alias setting, please delete the device on the topology and
then rescan or add a device to complete the 'Alias’ setting.
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b. Select one of the following properties from the Bottom Label drop-down:
O Location

O Alias
O Model Name
a MAC

MXview One displays the selected property below the IP address of the device.

Device Appearance

Preview

IP Address

Bottom Label

Location -

4. To modify the device alias:
a. Locate the Alias section.

A If you change the Alias setting, please delete the device on the topology and
then rescan or add a device to complete the 'Alias’ setting.

Alias
Bottom Label g Bottom Label

IP Address v Model Name v

b. From the first drop-down list in the Alias section, select one of the following:
IP Address

MAC

Model Name

Location

Qaaaaq

SysName
c. From the second drop-down list in the Alias section, select one of the following:
O IP Address

O MAC
O Model Name
O Location
O SysName
g
/7  NOTE

If you change the Alias setting, please delete the device on the topology and then rescan or add a device
to complete the 'Alias' setting.

5. Click Save.
MXview One updates the modified settings.
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Exporting the Topology Map

MXview One allows you to export the Topology Map as a PNG image.

1. Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.
2. If List view is selected, click the Topology view (%) icon in the top right corner.

The Topology screen will display a graphical representation of the devices and links on your network.

3. Navigate to Edit > Export Topology.
MXview One exports the PNG image of the Topology Map.
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8. Network and Traffic Monitoring

MXview One allows you to monitor the traffic between devices on your network and trigger events for
specific traffic conditions. You can apply topology views to monitor traffic load, network security, as well as
wireless access points and clients.

Viewing Link Properties

Click a link on the Topology Map to view link properties and perform the following:

1. Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map by default.
2. Click on a link between devices in the Topology Map.

The Link Properties pane appears to the right of the Topology Map.

All > Site MOXA-KKABRVUM70 > Root

ﬁ Link Traffic v ZX Severity Threshold B Set Port Label E Delete = o
Q Link Properties
Coupling Coupling
GOOSE = : Link Information
L Sy 10216h07 108 192168120 192168127.105
) ‘ From

192.168.127.103

Port 4
192.168.127.106 I
[icur} To
Iuﬂ 2100123 192.168.127.1
192.168.127.1

Port 1

Link Speed

100 Mb
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Viewing Port Traffic

The Port Traffic screen displays a graph that shows the utilization percentage (Y-axis) over a specific time
period (X-axis). You can also adjust the time period for the data that is displayed by changing the starting
date and ending date. The minimum interval you can select is one day and the maximum interval you can
select is 90 days.

1. Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.
2. Click on a link between devices in the Topology Map.

The Link Properties pane and the following toolbar appear when a link is selected.
&P Link Traffic v X Severity Threshold @ Set Port Label B Delete

3. Navigate to Link Traffic > Port Traffic.
The Port Traffic screen will appear.

Port Traffic

5/3/2022 B 5/3/2022 ©

i L
Il
a1
b | ’|i‘ 1
AMALL

1
ERYATRI|
il

17 18 19 20 21 22 23 00 01 02 03 04 05 06
5/2/22 5/3
UTC +08:00
Time From To Value
RX
Omx

Close

4. To adjust the time period for the graph data:
a. Click the From date and select a new starting date.
b. Click the To date and select a new ending date.

5. Hover over a line to view the direction of traffic.

For example, the green line at the top of the following graph represents traffic from 192.168.127.1
(device IP address) Port 1 to 192.168.127.103 (device IP address) Port 4.

Port Traffic

0.025%

I e ‘
i

‘nf‘m.\ g

[

I |
L Ly .n[ Wil
L WITLY RN |

|

0.02% | fin.p. .\ W 4(1 I | AMIEmA! L

AR ST TR 0

i \H‘”‘ U’” \‘f‘ \M‘a VY H‘JH
r

TR T T Iy
VALY ML WL
ey ‘( ‘J’W ‘\“M‘J‘L‘r
u U U

oo1s%

0.01%

0.005%

0%

17 18 19 20 21 22 23 00 01 02 03 04 05 06
5/2/22 5/3
UTC +08:00
Time From To Value
[CJRX 2022-05-02 21:15:01 192.168.127.1 Port 1 192.168.127.103 Port 4 0.0002%

[JTX 2022-05-02 21:15:01 192.168.127.103 Port 4 192.168.127.1 Port 1 0.0229%

Close
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Viewing Packet Error Rates

The Packet Error Rate screen displays a graph that shows the packet error rate (Y-axis) over a specific
time period (X-axis). You can also adjust the time period for the data that is displayed by changing the start
and end dates. The minimum interval is one day and the maximum interval you can select is 90 days.

1. Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.
2. Click on a link between devices in the Topology Map.
The Link Properties pane and toolbar appear when a link is selected.
@B Link Traffic v X Severity Threshold B Set Port Label B Delete
3. Navigate to Link Traffic > Packet Error Rate.

The Packet Error Rate screen appears.

Packet Error Rate

12/28/2021 B 12/29/2021 o]
03 06 09 12 15 18 21 00 03 06 09 12
12/28/21 12/29
UTC +08:00
Time From To Value
dinput
[ Output

4. To adjust the time period for the graph data:

5.

a. Click the From date and select a new starting date.
b. Click the To date and select a new ending date.

Hover over a line to view the packet error rate.

Packet Error Rate

From To

12/29/2021 B 12/29/2021 B

0.6%
0.5% i
0.4% H
03% i)

I
0.2% \

01% oA
WA\
0% | \

13:40 13:50 14:00 1410 14:20 14:30 14:40 14:50
12/29/21
UTC +08:00
Time From To Value
RX Error 2021-12-29 13:36:26 192.168.127.154 Port 2 192.168.127.151 Port 11 0.4%
I TX Error  2021-12-29 13:36:26 192.168.127.151 Port 11 192.168.127.154 Port 2 0.6%

Close

Close
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Monitoring Traffic Loads

MXview One collects the traffic load information of every link and displays the information to provide users
with a network-wide view.

1.

Navigate to Menu (E) > Topology.

The Topology screen will appear and displays the Topology Map by default.

If List view is selected, click the Topology view ( *) icon in the top right corner.

The Topology screen will display a graphical representation of the devices and links on your network.
From the toolbar menu, navigate to Visualization > Traffic View.

@ Visualization v @z SFP v
&k Traffic View
@ Security View

“~ Wireless Table View

The Traffic Load legend will appear and the Topology Map color-codes each link to indicate the traffic
load.

s Luad(%) c X _
0 20 40 60 80 100

@R0%

N

o

Monitoring Network Security

ISA/IEC 62443 is a continuously evolving cybersecurity standard whose guidelines have already been
adopted in many industrial automation applications. This standard, including its subsections, aims to cover
points such as general requirements, policies and procedure, system-level requirements, and component-
level requirements.

Moxa’s MXview One follows Moxa’s security guidelines, which are based on the IEC 62443-4-2 component-
level recommendations. Security View checks the security level of Moxa’s network devices. There are five
levels for checking the results in Security View:

High

Medium

Basic

Open: Security Level below basic

Unknown: Devices without security-related information for MXview One
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/  NOTE

The definition of general baseline is based on several industrial cybersecurity policies and requirements.

1. Navigate to Menu (E)) > Topology.
The Topology screen will appear and display the Topology Map by default.

2. If List view is selected, click the Topology view ( *) icon in the top right corner.
The Topology screen will display a graphical representation of the devices and links on your network.

3. From the toolbar menu, navigate to Visualization > Security View.

The Security View window will appear and the Topology Map indicates the security level of each device

with a color-coded circle.

All > client-generic > Root

W Maintenance v W Tools v " ChangeGroup [ Document ! Refresh @ Locator GO AddLink [ Delete = 0
Security View Co =X | 1t Status Security View
Bih “Molian * [Base ' ipen  okaown (3] Device Security LeveLHigh
30 result of fiter All" ~ o i icdong
eHign
| = coo SmESIIIIT @
10.81.10.11
Y | o S Taomortn g
10811012 e 4
. ] II EDS510E - ® @ @ Enable Trusted Access 9
[} I. ‘Smmg - ® @ @ Enable Auto Logout 9
1 ‘ ) @ @ Enable DDoS Protection (]
e e i
\’\_\ . é ..Ena:le:&ccounﬁLug\nFalluve ©
B g SN TER L g
R R 3
;i/w = 4 I= = E::s;(‘coonnﬁgmauon File 9
-~ - N L -
4. To filter the devices in the Security View window by security level:
a. Click the Filter (E) icon.
b. Select the security level.
The Security View window filters the list of devices to only show devices that match the selected
security level.
5. To locate a device in the Topology Map, click the device in the Security View window.
High Medium Basic Open Unknown
3 results for "All .
192.168.127.1
g 192.168.127 1-ICMP Device
192.168.127.252
192.168.127.252--EDS-5054
- 192.168.127.253
g 192.168.127.253-EDS-508A
83
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The Security View details pane will appear on the right and the Topology Map highlights the circle
around the device.

it Status Security View

Device Security Level:High

@ Basic
@ Medium
@ High

Change Default Password / °
®®® syMP community String

Set SNMP Trap/Inform or Syslog
SO8® server 9

" @ @ @ Enable Trusted Access °

@ @ @ Enable Auto Logout
@ @ Enable DDoS Protection

Enable Password Complexity
e Strength Check

Enable Account Login Failure
®® | ockout

Disable Mon-encrypted TCP/UDP
®® poris

@ @ Set Login Message

Enable Configuration File °
® Encryption

6. View security details for a specific device by using one of the following methods:
> Select a device from the Topology Map.
» Select a device from the Security View window.

The Security View details pane will appear and displays the device security level and security-related
configuration statuses.

7. View the Security View Report:
Click Export to export the Security View Report in either CSV or PDF format.

Security View & = Bl X
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8. Review the following items in the Security View details pane:

Item Description

Enable Auto Logout Check if the Auto Logout function is enabled.

Check if both the Web Login Message and Web Login Fail Message
are configured.

Check if non-encrypted TCP/UDP Ports are disabled. HTTP, Telnet,
and Moxa Proprietary Protocol should be disabled. SNMP must be
set to V3 only.

Set Login Message

Disable Non-encrypted TCP/UDP
Ports

Enable Account Login Failure

Check if the Account Login Failure Lockout function is enabled.
Lockout

Check if the Trusted Access function is enabled or not. At least one
rule must be set.

Enable Password Complexity Check if the Password Complexity Strength Check function is
Strength Check enabled.

Check if the Configuration File Encryption function is enabled. At
least one rule must be enabled.

Check if Broadcast Storm Protection is enabled. For eCos switches,
MXview One checks whether Broadcast Storm Protection is
enabled. For EDR routers, MXview One checks whether at least
one form of DoS protection is enabled. For MXnos switches,
MXview One checks whether at least one of the following is
enabled: Broadcast, Multicast, or DLF protection.

Enable Trusted Access

Enable Configuration File Encryption

Enable DDoS Protection

Set SNMP Trap/Inform or Syslog
Server

Change Default Password/SNMP
Community String

Enable SSL/TLS High Secure Mode |[Check if the HTTPS is enabled and HTTP is disabled.

Check if the SNMP Trap/Inform or Syslog Server is set.

Check if the Default Password or SNMP Community String is set.

/7  NOTE

Users can use Security Wizard function in MXconfig to easily set the Security View status of devices.

9. To modify the colors used to indicate the security levels:
a. Navigate to Menu (E) > Administration > Preferences.
The Preferences screen will appear.
b. Under the Appearance section, expand Security View.
c. In the Colors for check result section, modify the color used to indicate a security level.

Security View ~

Profile

Built-in Profile ¥ Profile details [

Colors for check result

High Medium

I #77B800 B #o09DDB

Basic QOpen

[ #FA943E [] #cococo
d. Click Save.
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10. To define a custom security profile:
a. Navigate to Menu (E) > Administration > Preferences.
The Preferences screen will appear.
b. Under the Appearance section, expand Security View.
c. From the Profile drop-down list, select User defined.
The user-defined profile settings will appear.

Security View

Profile
User defined v

Colors for check result

. #77B800

Not Pass

#FA943E

Switch NPORTS5000A Device Server >

11|
T+

Check Item

[[] Enable Auto Logout

[C] SetLogin Message

d. (Optional) Modify the colors for the check result.

e. Click one of the following device tabs to configure the profile settings:
Switch

NPORT5000A

Device Server

Terminal Server

Gateway

Wireless

10

f. (Optional) Click the Settings (1_-5) icon to select a baseline.

[ I [ I [ |

g. Select the check box for each item you want to add to security profile.

h. Click Save.
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Configuring Severity Thresholds for Traffic and
Fiber Status Monitoring Events

MXview One allows you to configure the following traffic conditions on a link to trigger events:

Bandwidth utilization is over the threshold.
Bandwidth utilization is under the threshold.
Packet error rate is over the threshold.
Fiber Rx is under the threshold.

Fiber Tx is under the threshold.

Fiber temperature is over the threshold.
Fiber voltage is under the threshold.

Fiber voltage is over the threshold.

Since a link is bidirectional, the event will be triggered when the traffic condition in either direction satisfies
the configured severity threshold.

1.

Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map by default.
Click on a link between devices in the Topology Map.

The Link Properties pane and toolbar appear when a link is selected.

&P Link Traffic v X Severity Threshold @ Set Port Label B Delete

Click Severity Threshold.
The Severity Threshold screen will appear.

Severity Threshold
Bandwidth Utilization Packet Error Rate SFP Threshold
0 Warning -
0 Warning v
Cancel Apply
Severity Threshold
Bandwidth Utilization Packet Error Rate SFP Threshold
0 Warning ¥
Cancel Apply
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Severity Threshold

Bandwidth Utilization Packet Error Rate SFP Threshold
0 Warning v
0 | Warning -
0 | Warning v
0 Warning -

0 Warning -

Cancel

4. To trigger an event when the bandwidth utilization on a link exceeds a specified percentage:
Click the Bandwidth Utilization tab.
In the Over field, specify the maximum bandwidth utilization percentage.
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
O Warning
O  Critical
5. To trigger an event when the bandwidth utilization on a link falls below a specified percentage:
Click the Bandwidth Utilization tab.
In the Under field, specify the minimum bandwidth utilization percentage.
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
O Warning
O Critical
6. To trigger an event when the packet error rate exceeds a specified percentage:
Click the Packet Error Rate tab.
In the Over field, specify the maximum bandwidth utilization percentage.
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
O Warning
O  Critical
7. To trigger an event when the SFP Tx falls below a specific range:
Click the SFP Threshold tab.
In the SFP Tx Under field, specify the maximum Tx threshold in dB (0~-100)
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
O Warning
O Critical
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8. To trigger an event when the SFP Rx falls below a specific range:
a. Click the SFP Threshold tab.
b. In the SFP Rx Under field, specify the maximum Rx threshold in dB (0~-100)
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
O Warning
O  Critical
9. To trigger an event when the SFP voltage falls below a specific range:
a. Click the SFP Threshold tab.
b. In the SFP Voltage Under field, specify the maximum voltage in V (0~10)
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
O Warning
O Critical
10. To trigger an event when the SFP voltage exceeds a specific range:
a. Click the SFP Threshold tab.
b. In the SFP Voltage Over field, specify the minimum voltage in V (0~10)
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
O Warning
O Critical
11. To trigger an event when the SFP temperature exceeds a specific range:
a. Click the SFP Threshold tab.
b. In the SFP Temperature Over field, specify the minimum temperature in Celsius (0~100)
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
0O Warning
O  Critical
12. Click Apply.
MXview One will update the modified settings.
13. (Optional) Configure the Severity Threshold and Fiber status:
a. Navigate to Menu (E) > Administration > Global Device Settings.
The Global Device Settings screen appears.
b. To set the threshold, you can go to the sections below to complete the settings.
O Bandwidth Utilization
O Packet Error Rate
O SFP Threshold
c. Click Save.
MXview updates the web console protocol settings.

/  NOTE

If you complete the Bandwidth Utilization, Packet Error Rate, and SFP Threshold settings in the Global
Device Settings section, the settings will be implemented to all the devices in your topology.
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Configuring Custom Port Labels

MXview One uses the following port labelling convention to identify directions of traffic on a link.
<Device IP Address> / <Port Number>
You can use the Set Port Label screen to customize the port labels.

1. Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map by default.
2. Click on a link between devices in the Topology Map.

The Link Properties pane and toolbar appear when a link is selected.

@B Link Traffic v X Severity Threshold B Set Port Label B Delete

3. Click Set Port Label.
The Set Port Label screen appears.

Set Port Label

[C] Use Custom Label

From:10.81.10.12 / Port 8

To:10.81.10.11 / Port 8

Cancel Apply

In the From field, provide a new label for the source port.

Select the Use Custom Label check box.

In the To field, provide a new label for the destination port.

N o u ok

Click Apply.
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9. SFP Fiber Status

Viewing the SFP Fiber Status in Table View

MXview One collects and display fiber status in SFP > SFP List

s Topology v @ Group v g Edit v (® Visualization v @z SFP v ’ Power v

Q SFP List

(&) Sync Threshold From the D..

The list shows Fiber TX, RX, temperature, and voltage of the cables that are connected.

SFP List
c Q, search
TX(dBm) RX(dBm) Temp. (°C) Volt. (V) TX (dBm) RX(dBm) Temp. (°C) Volt. (V)
10.81.10.12 10.81.10.11
-6.1 -6.3 421 3.3 -6 -5.9 43 33
Port 8 / SFP-1GSXLC Port 8 / SFP-1GSXLC
10.81.10.10 10.81.10.11
-6.3 -5.8 41.6 33 -6.2 -6.1 442 3.3
Port 8 / SFP-1GSXLC Port 9 / SFP-1GSXLC
10.81.10.12 10.81.10.13
-6 =0 43.7 38 =6:1 =6:2 40.7 3.4
Port 9 / SFP-1GSXLC Port 8 / SFP-1GSXLC
»
tems per page: 50 ¥ -30f3
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Synchronize the SFP Threshold From the
Device

MXview One can synchronize the threshold from devices, which can detect Moxa's SFP connector to get the
specific threshold.

Navigate to SFP > Sync Threshold From the Device

2 Topology v e Group v 2 Edit v ® Visualization v aZ SFP v ’ Power v
Q, i= SFPList

(&) Sync Threshold From the D..

Click Sync and the threshold from the devices will sync to the SFP Threshold of every link.

Sync the SFP Threshold From the Device

You can sync the SFP Threshold from Moxa's switch. After syncing, the
Temperature, Tx Power, and Rx Power of Fiber Check will be synced to
the SFP Threshold of every link.

on a link, then

Bandwidth Unilizat Packet Error Rate SFP Threshold

o Warning -

o ‘Warmning
o Warning -
o Waming
0 . Warmning

Are you sure you want to sync the SFP threshold from the device?
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10.

Device Management

The MXview One Topology screen provides several features and tools for managing and maintaining

devices in your network topology.

Viewing the Device List

The List view on the Topology screen will display a list of discovered devices in your network topology.

You can also use this view to manually add devices to your network topology or export filtered data as a

CSV file.

2/ Editv
=&

[J SiteName

[J Site DESKTOP-DK412LE
) Site DESKTOP-DK412LE
E Site DESKTOP-DK412LE
[J Site DESKTOP-DK412LE
[J Site DESKTOP-DK412LE
[J Site DESKTOP-DK412LE
(]
El

Site DESKTOP-DK412LE

Site DESKTOP-DK412LE

_

Device Alias

192.168.127.151-EDS-G516E

192.168.127.152-EDS-518A

192.168.127.153-EDS-405A

192.168.127.154-NPort-S8000

192.168.127.155-NPort-S8000

192.168.127.156-1EX-402-SHDSL.

192.168.127.157~IEX-402-SHDSL.

192.168.127.158~ICMP Device

Device IP

192.168.127.151

192.168.127.152

192.168.127.153

192.168.127.154

192.168.127.155

192.168.127.156

192.168.127.157

192.168.127.158

1. Navigate to Menu (E) > Topology.

MAC Address

00:90:E8:44:52:AE

00:90:E8:00:00:55

00:90:E8:23:7E:97

00:90:E8:34:FC:15

00:90:E8:34:FC:07

00:90:E8:01:02:10

00:90:E8:FE:DD:10

00:90:E8:43:37:92

Q search

Firmware Version

V6.2 build 20080519

V3.9 build 21110513

V3.10 build 19121910

V1.75

V1.7

V1.0 build 12112311

V1.0 build 12112311

Location

NSD Lab aa

NSD Lab

NSD Lab

NSD Lab

NSD Lab

NSD Lab

NSD Lab

The Topology screen will appear and display the Topology Map in Topology view.

2. Click the List view (¥ icon in the top right corner.
The Topology screen displays a list of devices on your network.

3. To add a device to your network topology:
a. Click Edit > Add Device.
The Add Device screen will appear.

Add Device

IP Address *

Assign Model *

SNMP Ve

Vi

public

~ 161

Password

private

Assign to Group * b

Encryption Password

Cancel
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b. Configure the following:

O IP Address: Specify the IP address of the device
Assign Model: Select the model of the device
Assign To Group: Select the group to assign the device to
SNMP Version: Select the SNMP version
Username: Specify the device login Username
Password: Create a password
Read Community: Specify the SNMP read community string
Write Community: Specify the SNMP write community string
Data Encryption: Select the data encryption method
Authentication: Select the authentication method

Qoo oooaoaoaaq

Encryption Key: Specify the encryption key
c. Click Add.
MXview One adds the device to the topology.
4. To delete devices in your network topology:
a. Check the box on the first column of devices.

b. Click the Delete (E) icon on the menu bar. The Delete Device screen appears.

c. For non AWK devices, read the message and then click Delete if you are sure you want to delete
the device.

Delete Device

Are you sure you want to delete this device?

d. For AWK devices, read the message and wait for the countdown. Click Delete if you are sure you
want to delete the device.

Delete Device

A Confirmation of device(s) deletion

Historical data of deleted wireless client
device(s) will also be purged and affect
traceability of listed features. Do you want
to proceed?

* Wireless Roaming Playback

s Device Dashboard

/7  NOTE

If you click the check box for all the devices, when you click the Delete icon, you will delete all the devices
in the topology.
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5. To view device properties, select the check box next to the Site Name.
The Device Properties details pane will appear.

Device Properties Current Status

Basic Device Properties

Alias
EDS-510E

Model Name
EDS-510E

MAC Address
00:90:E8:86:2F:16

Availability
100.00%

System Description
EDS-510E-3GTXSFP

System Object ID
.1.3.6.1.4.1.8691.7.84

6. To filter the device list by severity level:
a. Click the Filter (¥) icon in the top left corner.
The Severity drop-down list appears.

X

Severity ¥

< Reset Apply

b. Select one of the following severity levels:
O  Critical
O Warning

O Information
c. Click Apply.
MXview One filters the device list to only display devices with the selected severity level.

7. To export the device list:

a. Click the Export (@) icon.

= o

[ | Exportcsv
M rantAsnare

b. Select Export CSV.
MXview One will export the displayed data as a CSV file.
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Importing Device Configurations

Use the Topology screen to import an INI-formatted configuration file to a device in your network topology
by selecting the device from the Topology Map or Device List.

1.

5.

Navigate to Menu (E) > Topology.

The Topology screen will appear and displays the Topology Map by default.

Select one of the following views:

» Topology view: Displays a graphical representation of devices in your network topology.
> List view: Displays a list of the devices in your network topology.

Select the device that you want to import configurations to:

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the site name in the Device List.

The toolbar options change.
\\ Maintenance v \ Tools v /‘ Change Group (@ Refresh GD Add Link E Delete

Navigate to Maintenance > Import Config.
The Import Config screen appears and indicates the IP address of the selected device.

Import Config - 192.168.127.252

Import Config * (|

The maximum file size is 1 MB

* Please make sure the username and password
for this device are correctly set in "Advanced
Settings"

Cancel

Click the folder (M®) icon to upload the configuration file from your local machine.

6. Click Import.

MXview One imports the configuration file to the specified device.

MXview One 1.2.0 User Manual

96



Exporting Device Configurations

Use the Topology screen to export an INI-formatted configuration file from a device in your network
topology by selecting the device from the Topology Map or Device List.

1.

5.

Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map by default.

Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.
> List view: Displays a list of the devices in your network topology.

Select the device that you want to export configurations from.

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.

The toolbar options change.
R Maintenance v * Tools v /‘ Change Group (@ Refresh GD Add Link E Delete

Navigate to Maintenance > Export Config.
The Export Config screen will appear and indicate the IP address of the selected device.

Export Config - 192.168.127.252

* Please make sure the username and password
for this device are correctly set in "Advanced

Settings"
Click Export.

MXview One exports the device configurations as an INI file in the specified location.
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Upgrading Firmware

Use the Topology screen to upgrade the firmware (ROM-formatted file) on a device in your network
topology by selecting the device from the Topology Map or Device List.

1.

5.

Navigate to Menu (E) > Topology.

The Topology screen appears and displays the Topology Map by default.

Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.
b. List view: Displays a list of the devices in your network topology.

Select the device that you want to upgrade the firmware for:

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.

The toolbar options change.
R Maintenance v * Tools v /‘ Change Group (@ Refresh GD Add Link E Delete

Navigate to Maintenance > Upgrade Firmware.
The Upgrade Firmware screen appears and indicates the IP address of the selected device.

Upgrade Firmware - 192.168.127.252

Upgrade Firmware * |

* Please make sure the username and password
for this device are correctly set in "Advanced
Settings"

Cancel

Click the folder (M®) icon to upload the ROM-formatted firmware file from your local machine.

6. Click Upgrade.

MXview One will upgrade the firmware on the specified device.
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Configuring SNMP Trap Server

MXview One can collaborate with other network management software and send SNMP Traps to non-Moxa

NMS. MXview One supports up to two trap servers depending on the device.

1. Navigate to Menu (E) > Topology.
The Topology screen will appear and display the Topology Map by default.
2. Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
3. Select the device.
» Topology view: Click the icon of the device in the Topology Map.
» List view: Select the check box next to the device in the Device List.
The toolbar options change.

\\ Maintenance v \ Tools v /‘ Change Group (@ Refresh GD Add Link

4. Navigate to Maintenance > Trap Server.
The Trap Server screen appears.

Trap Server

Destination IP1 *

10.82.10.6

Community Name1 *

public

Destination IP2 *

Community Name2 *

public

Cancel

5. Configure the following SNMP trap server settings for the device:
> Destination IP1
> Community Namel
» (Optional) Destination IP2
» (Optional) Community Name2
6. Click Apply.

E Delete

MXview One sends SNMP traps to the configured trap server(s) when events are detected on the device.

NOTE

When a device fails to reply within seven seconds, MXview One will display the message "Failed to update
device Trap server settings." Please confirm the execution results via the same settings page or go to the

web page of the devices.
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Configuring Port Settings

Use the Topology screen to configure port settings for a device in your network topology by selecting the
device from the Topology Map or Device List.

1.

Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.
Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
Select the device.

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.
The toolbar options will change.

\\ Maintenance v * Tools v /‘ Change Group (@ Refresh GD Add Link

Navigate to Maintenance > Port Settings.
The Port Setting screen appears.

Port Settings

1 v

Enable *

Enabled v

Media Type

Port Description

Apply settings to another port  ~

Cancel Apply

Configure the following port settings for the device:

> Port: Select the port number.

> Enable: Enable or disable the port.

> Port Description: Provide a description of the port.
>

E Delete

Apply settings to another port: Select to apply the configured settings to other ports on the

device.
Click Apply.
MXview One will update the port settings to the device.
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Configuring SNMP Configuration

Use the Topology screen to configure SNMP settings for a device in your network topology by selecting the
device from the Topology Map or Device List.

1.

Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.
Select one of the following views:

> Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
Select the device.

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.
The toolbar options will change.

\\ Maintenance v * Tools v /‘ Change Group (@ Refresh GD Add Link
Navigate to Maintenance > SNMP Configuration.
The SNMP Configuration screen will appear.

SNMP Configuration

SNMP Version * Port *

V3 ¥ 161

User Name

admin ©

Read Community Write Community

Data Encryption Authentication

AuthPriv ¥ SHA v

Encryption Protoco Encryption Password

DES v seesssns Q

Cancel Apply

Configure the following SNMP settings for the device:
SNMP Version

SNMP Port

Username

Password

Read Community

Write Community

Data Encryption

Authentication

Encryption Protocol

YV V.V V V V V V VYV VY

Encryption Password
Click Apply.
MXview One updates the SNMP configuration settings to the device.

E Delete
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7

NOTE

For the first time, users can use the Device Settings Template function to set the function template. For

more information, see Changing Default SNMP Configuration.

Configuring Polling Settings

Use the Topology screen to configure ICMP or SNMP polling settings for a device in your network topology
by selecting the device from the Topology Map or Device List.

1. Navigate to Menu (E) > Topology.
The Topology screen will appear and display the Topology Map by default.
2. Select one of the following views:
» Topology view: Displays a graphical representation of the devices in your network topology.
> List view: Displays a list of the devices in your network topology.
3. Select the device.
» Topology view: Click the icon of the device in the Topology Map.
» List view: Select the check box next to the device in the Device List.
The toolbar options change.
\\ Maintenance v R Tools v /‘ Change Group C Refresh GD Add Link E Delete
4. Navigate to Maintenance > Polling Settings.
The Polling Settings screen appears.
Polling Settings
ICMF nter
10
ol
5. Configure the following polling settings for the device:
» ICMP polling interval
» SNMP polling interval
6. Click Apply.
MXview One will update the polling settings for the device.
g
/  NOTE

For the first time, users can use the Device Settings Template function to set the function template. For

more information, see Configuring Device Polling Settings.
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Configuring Advanced Settings

Use the Topology screen to configure advanced settings for a device in your network topology by selecting
the device from the Topology Map or Device List.
1. Navigate to Menu (E) > Topology.
The Topology screen will appear and display the Topology Map by default.
2. Select one of the following views:
> Topology view: Displays a graphical representation of the devices in your network topology.
> List view: Displays a list of the devices in your network topology.
3. Select the device.
» Topology view: Click the icon of the device in the Topology Map.
» List view: Select the check box next to the device in the Device List.
The toolbar options change.

\\ Maintenance v \ Tools v /‘ Change Group (@ Refresh GD Add Link E Delete

4. Navigate to Maintenance > Advanced Settings.
The Advanced Settings screen appears.

Advanced Settings

[C] Modify Device Alias

o o

Cancel Apply

5. To modify device alias:

a. Select the Modify Device Alias check box.

b. Edit the Alias field.
6. To specify login credentials for the device web console

Enter the Username and Password for the device web console.
7. Click Apply.

MXview One updates the advanced settings.
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Changing the Device Icon

Use the Topology screen to change the device icon by selecting the device from the Topology Map or
Device List, and then upload a JPG, GIF, or PNG image file.

1.

Navigate to Menu (E) > Topology.
The Topology screen will appear and display the Topology Map by default.
Select one of the following views:

> Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
Select the device.

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.
The toolbar options will change.

\\ Maintenance v \ Tools v /‘ Change Group (@ Refresh GD Add Link

Navigate to Maintenance > Change Device Icon.
The Change Device Icon screen appears.

Change Device Icon

IP Address: 10.81.10.11

Model Icon * (| [E

Cancel

E Delete

Click the folder (M) icon to upload the device icon from your local machine. (The maximum image size

is 100 kB.)
Click Apply.
MXview One will change the device icon to the uploaded JPG, GIF, or PNG image file.
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Signing on to Device Web Consoles

MXview One allows you to use the Topology screen to the web console for a device from the Topology
Map or Device List.

7

NOTE

You can use the Global Device Settings screen to configure the web console protocol. The web console
protocol can be set to HTTP or HTTPS, and then the port numbers of the HTTP and HTTPS can be set by
users.

(Optional) Configure the web console protocol:

a. Navigate to Menu (E) > Administration > Global Device Settings.
The Global Device Settings screen appears.

b. Find the Management Interface to complete the settings.

Management Interface

HTTP i

c. Configure the following:
O Web Console Protocol
O HTTP Port
O HTTPS Port
d. Click Save.
MXview One updates the web console protocol settings.

NOTE

If you complete the Management Interface settings in the Global Device Settings section, the settings will
be applied to all the devices in your topology.

Navigate to Menu (E) > Topology.
The Topology screen will appear and display the Topology Map by default.
Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
Select the device.

» Topology view: Click the icon of the device in the Topology Map.

> List view: Select the check box next to the device in the Device List.

The toolbar options change.
\\ Maintenance v \\ Tools v ,’ Change Group (C Refresh GD Add Link

Navigate to Tools > Web Console.
The login screen for device web console appears in a new browser tab.

E Delete
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/  NOTE

You may need to allow pop-ups on your web browser in order to view the device web console.

6. Enter the Username and Password for the device web console.
7. Click Login.
The device web console will successfully log in.

Changing Device Groups

Use the Topology screen to change the assigned group for a device by selecting the device from the
Topology Map or Device List.
1. Navigate to Menu (E) > Topology.
The Topology screen will appear and display the Topology Map by default.
2. Select one of the following views:
» Topology view: Displays a graphical representation of the devices in your network topology.
> List view: Displays a list of the devices in your network topology.
3. Select the device.
» Topology view: Click the icon of the device in the Topology Map.
> List view: Select the check box next to the device in the Device List.
The toolbar options change.

\\ Maintenance v * Tools v /' Change Group C Refresh GD Add Link E Delete

4. Click Change Group.
The Change Group screen will appear and displays the following information:

Change Group

Root -

IP Address
10.81.10.10
10.81.10.11
10.81.10.12
10.81.10.13
10.81.10.14
10.81.10.13
10.81.10.16

10.81.10.17

-
d
O
a
O
O
d
O

5. (Optional) Select additional IP addresses to assign other devices from the current group to the new
group.
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From the Assign to Group drop-down list, select the new group that you want to assign the selected
device(s) to.

Click Apply.
MXview One will assign the selected device(s) to the new group.

Refreshing the Device Status

Since some device data is collected by polling, there may be a time delay for some data. Use the Topology
screen to refresh the device status by selecting the device from the Topology Map or Device List.

1.

Navigate to Menu (E) > Topology.

The Topology screen appears and displays the Topology Map by default.

Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.
> List view: Displays a list of the devices in your network topology.

Select the device.

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.

The toolbar options change.

\\ Maintenance v R Tools v /‘ Change Group C Refresh GD Add Link E Delete

Click Refresh.
MXview One polls the device for updated data.

Deleting Devices

Use the Topology screen to delete devices from the Topology Map. After a device is deleted, it will be
removed from the topology map and the device will not be polled.

1.

Navigate to Menu (E) > Topology.

The Topology screen appears and displays the Topology Map by default.

Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.
> List view: Displays a list of the devices in your network topology.

Select the device.

» Topology view: Click the icon of the device in the Topology Map.

> List view: Select the check box next to the device in the Device List.

The toolbar options will change.

\ Maintenance v % Tools v /‘ Change Group C Refresh GD Add Link E Delete

Click Delete.
MXview One removes the device from your network topology.
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11. Events and Notifications

MXview One allows you to monitor system events, create custom monitoring events, and configure event
notifications.

Event Monitoring

Viewing Event History

The Event History screen provides information about all the network events for devices in your topology.
Use the filters to customize the information displayed in the table. You can also export the data as a CSV

file.
. R
Event History
é
[
O Site Name ID Source  Source IP Device Alias Description Time Issued
B MXview 192.168.127.158-ICMP 2022-05-05
4 i ANG- 109 192.168.127.1 MP h:
S O (M] B Site BRANDONYANG-PC 096 One 92.168.127.158 Device Device IC reachable 15:52:32
Bl MXview 192.168.127.158-ICMP 2022-05-05
~ ; g ;
O [M] B Site BRANDONYANG-PC 1095 One 192.168.127.158 Device Device ICMP unreachable 15:52:32
MXview 192.168.1.130-ioLogik- 2022-05-05
| i =
O (M] E Site BRANDONYANG-PC 1094 Ohe 192.168.1.130 W5312 Device SNMP unreachable 15:51:55
) MXview 192.168.1.130-ioLogik- . 2022-05-05
= Site BRANDONYANG-PC 1093 192.168.1.130 D ICMP habl
O& B st One W5312 SHlES SRR SacR 15:51:52
MXvi 2022-05-05
O B Site BRANDONYANG-PC 1092 On:lew 192.168.1.129 192.168.1.129-AWK-1131A Device ICMP unreachable 15:51:25
MX 2022-05-05
O [  Site BRANDONYANG-PC 1091 Om:lew 192.168.1.129  192.168.1.129-AWK-1131A Device SNMP unreachable Ry
1 RIS L FAR AIAIRANN NALIR Annn ar an

1. Navigate to Menu (E) > Event Management > Event History.
The Event History screen will display the following information in a table format:

Column Description

Ack All Events/Acknowledge |Acknowledge status of the event

Show Details The detailed information of this event

Site Name The site to which the device that issued the event belongs
ID The unique identifier of the event

Source IP The IP address of the device that issued the event

Source The source of the event

Device Alias The unique name of the device

Description The description of the event

Time Issued The time the event was issued
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2. To filter the information in the table by specific criteria:

a. Click the Filter (<) icon in the top left corner.
The following screen will appear.

X
Severity *
Group
Site Name ¥  Root ¥ |P Address
Source *  Acknowle.. =
Start Date = Hour ¥ Minute ~ Second i
End Date @ Hour ~ Minute ~ Second %

b. Specify any of the following criteria:

Criteria _____|Description

Severity Select the severity level of the event
Site Name Select the site to which the device that issued the event belongs
Group Select the group to which the device is assigned
IP Address Specify the IP address of the device
Source Select the source of the event
Acknowledge Select the acknowledgement status of the event
Start Date Specify the start date and time for the event data to display
End Date Specify the end date and time for the event data to display
c. Click Apply.

MXview One filters the table to only display events that match the specified criteria.
3. To sort the data in the table by a specific column, click the column heading.
MXview One sorts the table by the column.

4. To export data displayed on the Event History screen:

a. Click the Export (E) icon.
=8 =
O Export CSV

O Export All Events to CSV 4

b. Select Export CSV for just the events on the first page or Export All Events to CSV for all event
pages.

MXview One exports the displayed event data as a CSV file.
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Viewing Syslog Events

The Syslog Viewer screen provides information about the syslog events on your network. Use the filters to
customize the information displayed in the table. You can also export the data as a CSV file.

Syslog Viewer

= @ W Q search

Ti
Site Name Severity i IP Address Facility Message
Stamp

items per page: 100 ¥ 00fo

1. Enable the built-in syslog server.
a. Navigate to Menu (E) > Administration > System Settings.
The System Settings screen appears.
b. Find the Syslog Server Configuration section.
The Syslog Server Configuration settings will appear.

Syslog Server Configuration
Enable built-in sysle rver

Disabled v

514
<

Select Enabled from the Enable built-in syslog server drop-down list.

Specify the syslog server communication port.
e. Click Save.
MXview One enables the built-in syslog server and starts logging syslog events.
2. Navigate to Menu (E) > Event Management > Syslog Viewer.
The Syslog Viewer screen displays the following information in a table format:

Comn Deseription

Site Name The site to which the device that issued the event belongs
Severity The severity of the event

Time Stamp The time the event was issued

IP Address The IP address of the device that issued the event

Facility The group the device is assigned to

Message The description of the event

3. To search the information in the table, type a full or partial string that matches the value in any of the
table columns.

MXview One searches the table to only display results that fully or partially match the specified string.
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4. To filter the information in the table by specific criteria:
a. Click the Filter (<) icon in the top left corner.
The following screen will appear.

X
Site Name » |P Address
Facility -
I_—Iiéherthan orequal.. ¥  Severity -
Start Date [ Hour v Minute -
End Date B Hour * Minute -

=
b. Specify any of the following criteria:

Criteria___|Deseription

Site Name Select the site to which the device that issued the event belongs
IP Address Specify the IP address of the device that issued the event
Facility Select the group to which the device is assigned

Select the criteria operator for matching the event severity level:
e Higher than or equal to

Priority
e Equals
e Lower than or equal to
Severity Select the severity level of the event
Start Date Specify the start date and time for the event data to display
End Date Specify the end date and time for the event data to display
c. Click Apply.

MXview One filters the table to only display events that match the specified criteria.
5. To sort the data in the table by a specific column, click the column heading.
MXview One sorts the table by the column.
6. To export data displayed on the Syslog Viewer screen:

a. Click the Export (E) icon.

= @ ¥

Site Export CSV te

Export All Syslog to CSV

b. Select Export CSV for just the first syslog page or Export All Syslog to CSV for all syslog pages.
MXview One exports the displayed syslog data as a CSV file.
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Configuring Event Thresholds and Severity Levels

Use the Preferences and Global Device Settings screen to configure default event thresholds and
severity levels.
1. Navigate to Menu (E) > Administration > Preferences.
The Preferences screen will appear.
2. In the Advanced section, expand Events.
The Events settings will appear.

Advanced
<
Events ™~
Link Up
Information -
ink Dowr
Information -

3. Select one of the following severity levels for Link Up events:
» Information
> Waning
» Critical
4. Select one of the following severity levels for Link Down events:
» Information
» Warning
» Critical
5. Navigate to Menu (E) > Administration > Global Device Settings.
The Global Device Settings screen will appear.

/  NOTE

Once you save the settings in the Global Device Settings section, the settings will synchronize to each
device in the topology.

6. To trigger events when network bandwidth utilization exceeds a threshold:
a. Select Enabled from the first Bandwidth Utilization Over drop-down list.

Bandwdth Utilizabion Crver

Enabled -

0 Waming A
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b. Specify the percentage of bandwidth utilization for the threshold.

[oN

Bandwdth Utilizabion Crver

Enabled -

MWL URNZ300on Lver Sevent

0 Waming A

Select the Severity level for the event.

7. To trigger events when network bandwidth utilization falls below a threshold:

a.

Select Enabled from the first Bandwidth Utilization Under drop-down list.

Bandwdth Utlizabion Under

Enabled A

Bandwedtn URlization Linde SEverl

0 WWaming -

b. Specify the percentage of bandwidth utilization for the threshold.

C.

Bandwadth Utilizabion Under

Enabled -

Bandwdth Utilizakion Under Sevent

0 Waming -

Select the Severity level for the event.

8. To trigger events when the packet error rate exceeds a threshold:

a.

Select Enabled from the first Packet Error Rate Over drop-down list.

Packet Emor Hate Cher

Enabled A
Packet Ermor Hate Cher Savent
0 WWaming -

b. Specify the packet error rate for the threshold.

C.

Packst Eror Hate Cver

Enabled v
Facket Error Rate Uver Sevent
0 Waming A

Select the Severity level for the event.
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9. To trigger events when the SFP TX value is below a certain threshold:

a. Select Enabled from the first SFP TX Under drop-down list.

SFP TX Under

Enabled hd
SFP TX Under * Severity *
0 Warning
-100-0 dBm

b. Specify the SFP TX threshold level.
SFP TX Under *
Enabled v
SFP TX Under Severity *
-50| 3  Warning
-100-0 dBm

10. To trigger events when the SFP RX value is below a certain threshold:

a. Select Enabled from the first SFP RX Under drop-down list.

SFP RX Under

Enabled v
SFP RX Under * Severity *
0 Warning
-100-0 dBm

b. Specify the SFP RX threshold level.
SFP RX Under *
Enabled e g
SFP RX Under Severity *
-50| $ Warning
-100-0 dBm

11. To trigger events when the SFP voltage is below a certain threshold:

a. Select Enabled from the first SFP Voltage Under drop-down list.

SFP Voltage Under
Enabled v

SFP Voltage Under * Severity *
0 Warning
0-10 vV
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b. Specify the SFP Voltage threshold level.

SFP Voltage Under *

Enabled v

SFP Voltage Under Severity *

5 $  Warning -
0-10 V

12. To trigger events when the SFP voltage is over a certain threshold:
a. Select Enabled from the first SFP Voltage Over drop-down list.

SFP Voltage Over

Enabled v

SFP Voltage Over * Severity *

0 Warning v
0-10 Vv

b. Specify the SFP Voltage threshold level.

SFP Voltage Over *

Enabled v

SFP Voltage Over * Severity *

5 Warning v
0-10 vV

13. To trigger events when the SFP temperature is over a certain threshold:

a. Select Enabled from the first SFP Temperature Over drop-down list.

SFP Temperature Over

Enabled v

SFP Temperature Over * Severity *

0 Warning v
0-100 °C

b. Specify the SFP Temperature threshold level.

SFP Temperature Over *

Enabled v
SFP Temperature Qver * Severity *
50 Warning v
0-100 €
\J
/  NOTE

If the threshold is set as '0', the threshold function will be disabled.

14. Click Save.
MXview One will update the event threshold settings.
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Notification Methods

MXview One supports email notifications for events. The notification method requires specific server
configurations.

Configuring Email Server Settings

Use the System Settings screen to configure an email server to send email notifications for event
notifications.
1. Navigate to Menu (E) > Administration > System Settings.
The System Settings screen will appear.
Find the Email Server Configuration section.
Configure the following:
Server Domain Name/IP
Port number
Encryption
Username
Password

VvV V V V V V

Sender Address
4. Click Save.
MXview One can send email messages for configured event notifications.

Notification Management

The Notification Management screen allows you to configure event notifications by issuing a registered
action (e.g., sending an email message to a specified recipient) when configured events are detected on
your network.

Notification Management

Notification Action

"Please go to Action Tab and add an action first"

a .
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Configuring New Event Notifications

MXview One event notifications require at least one registered action (e.g., sending an email message to a
specified recipient), which MXview One performs when a specified event is detected on your network.
1. Navigate to Menu (E) > Notification Management.
The Notification Management screen appears.
2. To register an action:
a. Click the Action tab.
The Action tab displays a list of registered actions (if any).

Notification Management

Notification Action

5] Q sea
Action Name Type Action Information

/7 W Test E-mail email@example.com

b. Click the Add () icon in the top right corner.
The Add notification action screen will appear.

Add notification action

Action Name *

Cancel

c. In the Action Name field, type a name to describe the action.
d. From the Type drop-down list, select one of the following actions:
O E-mail: Sends an email to the specified email address.
e. Provide additional information required for the action (if any).
f. Click Add.
The registered action appears in the table on the Action tab.
3. To add a new event notification:
a. Click the Notification tab.
The Notification tab displays a list of configured event notifications (if any).

Notification Management

Notification Action

@ Qse
o Notification Name Type Registered Devices. Registered Actions
0O/ W Test Device ICMP unreachable 2 Test;
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b. Click the Add () icon in the top right corner.
The Add notification screen appears.

Add notification

Cancel

In the Notification Name field, type a name to describe the event notification.
From the Type drop-down list, select the event type.
From the Registered Devices drop-down list, select the network device(s) you want to monitor.

S B < o}

From the Registered Actions drop-down list, select the action that MXview One performs when the
specified event is detected on the previously selected device(s).

g. Click Add.
The event notification appears in the table on the Notification tab.

Editing or Exporting Registered Actions

Use the Action tab on the Notification Management screen to edit registered actions or export a CSV file
containing registered action information.
1. Navigate to Menu (E) > Notification Management.

The Notification Management screen will appear.
2. Click the Action tab.

The Action tab displays a list of registered actions.
3. To edit a registered action:

a. Click the Edit (#") icon next to the action you want to edit.

The Edit notification action screen will appear.

Edit notification action

Test

I
E-mail -

email@example.com

b. Modify the following settings:
O Action Name
O Type
3 Action information
c. Click Apply.
The Action tab appears and displays the updated action information.
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4. To export data displayed on the Action tab:

a. Click the Export (E) icon.

[+ I

Export CSV |

O

b. MXview One exports the displayed action data as a CSV file.

Editing or Exporting Notification Configurations

Use the Notification tab on the Notification Management screen to edit configured notifications or
export a CSV file containing notification configuration information.
1. Navigate to Menu (E) > Notification Management.

The Notification Management screen will appear.
2. Click the Notification tab.

The Notification tab displays a list of configured notifications.
3. To edit a notification:

a. Click the Edit (/') icon next to the action you want to edit.

The Edit notification screen will appear.

Edit Notification

Notification N

Test

Type *

Device ICMP unreachable v
Registered Devices *

All devices e

Registered Actions *

Email v

Content

The device ICMP is unreachable. @

31 /2000
Cancel Apply

b. Maodify the following settings:
O Notification Name
O Type
O Registered devices
O Registered Actions
c. Click Apply.
The Notification tab appears and displays the updated notification information.
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4. To export data displayed on the Notification tab:

a. Click the Export (E) icon.
()
0O Export CSV

b. Select Export CSV.

MXview One exports the displayed notification data as a CSV file.

Custom Event Management

The Custom Event screen provides information about all the custom events configured on MXview One.
You can use the Custom Event screen to view whether a custom event is enabled or disabled, modify a
custom event, or export custom event configurations as a CSV file.

Custom Event

All(3)
o] Q search
| Critical (1)
(m} Event Name: Enabled/Disabled  Condition  Description Recovery Description Duration  Registered Devices
Warning (1)
I O » @ Dsled Enabled Qver 10 The DslLed1 value is over 10. Recovery 0 5
Information (1)
O » @ ifinDiscards.13 Enabled Below 10 The ifinDiscards.13 value is below 10.  Recovery 0 5
I O » @ cpuloading300s Enabled Qver 20 The cpuLoading300s is over 20, Recovery 0 5

Configuring Custom Events

The Custom Event screen allows you to define your own events to monitor with flexible detection

thresholds, severity levels, and duration times. You can also export the custom event configurations as a
CSV file.

Custom Events Management

Al (0)
= Q_search
I Critical (0)

Event Name i Condition

Recovery Description Duration  Registered Devices
Warning (0)

| Information (0)
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1. Navigate to Menu (E) > Event Management > Custom Event.
The Custom Event screen appears.

2. Click the Add () button in the top left corner of the screen.
The Add custom event screen will appear.

Add Custom Event

Enabled A

Cancel

3. Select the default event status:
» Enabled: MXview One monitors the event
> Disabled: MXview One does not monitor the event
4. Select one of the following severity levels for the event:
» Information
» Warning
» Critical
5. Click the Device Properties and select the device property to monitor.
Configure the following threshold criteria:
» Condition Operator: Select the criteria operator for matching the condition value
» Condition Value: Specify the value for the criteria operator to match

7. (Optional) In the Description field, type a string (up to 250 characters in length) to describe the
custom monitoring.

8. (Optional) In the Recovery Description field, type a string (up to 250 characters in length) to describe
how to recover from the event.

9. In the Duration field, users can specify how many times an event can happen without any action being
taken. If the number of times the event happens exceeds the Duration, then MXview One will send an
alert.

10. From the Register Devices drop-down list, select the devices to monitor for the custom event.
11. Click Add.

The custom event appears in the Custom Event table.

/7  NOTE

If the threshold is set as '0', the threshold function will be disabled.
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Viewing or Exporting Custom Event Settings

The Custom Event screen provides information about all the custom events configured on MXview One.
You can use the Custom Event screen to view whether a custom event is enabled or disabled, modify a
custom event, or export custom event configurations as a CSV file.

Custom Event

All (3)

I ] Q Search
| Critical (1)

] Event Name Enabled/Disabled  Condition Description Recovery Description Duration  Registered Devices

Warning (1)

I O # W IpAddr Enabled Over 10 123 456 5
Information (1)

o/ IpMask Enabled Equal 23 2525 sfdg 6 1

I\Z\/‘

dhPort2 Enabled NotEqual 50  gddfgsdg wedgzgbaeh 134 1

~

1. Navigate to Menu (E) > Event Management > Custom Event.
The Custom Event screen will appear and displays the following information in a table format:

Event Name The name of the event

Enabled/Disabled The monitoring status of the event

Condition The threshold criteria configured for the event

Description The description of the event

Recovery Description The recovery description of the event

Duration The number of times of consecutive pollings for the event
Registered Devices The number or registered devices that the event applies to

2. To search for information in the table, type a full or partial string that matches the value in any of the
table columns.

MXview One filters the table to only display events with values that fully or partially match the specified
string.

3. To filter the information in the table by event severity, click one of the color-coded severity levels in the
left-side panel.

All (0)

Critical (0)

Warning (0)

Information (0)

MXview One filters the table to only display events that match the selected severity level.
4. To sort the data in the table by a specific column, click the column heading.
MXview One sorts the table by the column.
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5. To export data displayed on the Custom Event screen:

a. Click the Export (E) icon.

a .

Export CSV

0

b. Select Export CSV.
MXview One exports the displayed event data as a CSV file.

Enabling/Disabling or Editing Custom Events

To enable or disable a custom event, edit the custom event settings.

1. Navigate to Menu (E) > Event Management > Custom Event.
The Custom Event screen appears.

2. Click the Edit (/‘) icon next to the event you want to enable/disable.
The Update custom event screen appears.

Update Custom Event
Enabled -
F)rmcal s
DslLed1

Qver = ?0

The DslLed1 is over 10.

Recovery

All devices -

e m

3. From the Enable Custom Event drop-down list, select one of the following:
> Enabled
> Disabled
Modify any additional event settings you wish to change.
Click Apply.
The Custom Event screen will appear and displays the updated event information.

/7  NOTE

If the threshold is set as '0', the threshold function will be disabled.
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12.

Reports

MXview One provides reports that summarize key information about your network devices.

Viewing Inventory Reports

Use the Inventory Report screen to view information about the devices on your network. You can also

export the report as a CSV file or a PDF file.

Inventory Report

=

Site Name

client-generic
client-generic
client-generic
client-generic
client-generic
client-generic
client-generic

client-generic

1. Navigate to Menu (E) > Reports > Inventory Report.
The Inventory Report screen appears and displays the following information in a table format:

IP Address
10.82.10.1
10.82.10.2
10.82.10.3
10.82.10.4
10.81.10.10
10.81.10.11
10.81.10.12

10.81.10.13

Alias
IKS-G6824A
EDR-G903
EDR-G903
1KS-G6824A
EDS-510E
EDS-510E
EDS-510E

EDS-510E

Model
IKS-G6824A
EDR-G903
EDR-G903
IKS-G6824A
EDS-510E
EDS-510E
EDS-510E

EDS-510E

MAC Address

00:90:E8:7D:A7:1F
00:90:E8:84:6E:80
00:90:€8:00:00:02
00:90:E8:7D:A7:12
00:90:E8:86:2F:12
00:90:E8:86:2F:15
00:90:E8:86:2E:F3

00:90:E8:86:2F:17

Q Search

System Description
IKS-G6824A-4GTXSFP

Unknown

IKS-G6824A-4GTXSFP
EDS-510E-3GTXSFP
EDS-510E-3GTXSFP
EDS-510E-3GTXSFP

EDS-510E-3GTXSFP

Firmware Version

V5.7 build 20011715

V5.7 build 20011715
V5.4 build 21042021
V5.4 build 21042021
V5.4 build 21042021

V5.4 build 21042021

Column Description

The site that the device belongs to

Site Name

IP Address

The IP address of the device

Alias

The unique name of the device

Model

The model number of the device

MAC Address

The MAC address of the device

System Description

The description of the device

Firmware Version

The firmware version of the device

2. To search for information in the table, type a full or partial string that matches the value in any of the

table columns.
MXview One filters the table to only display results that fully or partially match the specified string.

3. To sort the data in the table by a specific column, click the column heading.

MXview One sorts the table by the column.

4. To export the report data:

a. Click the Export (E]) icon.

b. Select one of the following report formats:
O Export CSV
0  Export PDF
MXview One exports the report data in the selected format.
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13.

Backups, Restores, and Compares

The MXview One web console provides several features to assist database backups and device configuration
migrations. MXview One allows you to back up or restore configurations for multiple devices, and also
compare changes between different versions of archived configuration files. You can also create scheduled
jobs to automatically export/import device configurations or back up the MXview One database.

Backing Up the MXview One Database

Use the DB Backup & Restore screen on the Control Panel to back up the MXview One database.

1.

uos W

Navigate to DB Backup & Restore on the MXview One Control Panel.
The Database Backup & Restore screen appears.

MXview One Control Panel

Server Control

Backup Restore

Caonfiguration

DB Backup & Restore

Name *

Plug-in Manager

Certificate

Choose the Backup tab to start the process of backing up the database.
In the Name field, specify the backup file name.
Click Save.

The message that the file of the backup database has been stored in the specified directory will be
displayed.

The database has been backed up to

C:\Users\ \AppData\Roaming\moxa\mxview
one\db_backup\20230709_120518

The Database backup completed will appear on the Historical backups list.

MXview One Control Panel

Server Control
Configuration

I DB Backup & Restore

Name * Backup test

Historical backups

Plug-in Manager

Certificate

Version Name Date Time
| Backup test 20221215 13:23:37
o Backup test2 20221215 13:42:02
[ XXX-20221223 20221223 14:09:09
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Backing Up Device Configurations

Use the Device Configuration Center screen to export configuration backup files from one or more
devices.

1.

Navigate to Menu (E) > Device Configuration Center.
The Device Configuration Center screen appears.

Click the Backup tab.

Available devices will appear in the Device List.

Configuration Center

Backup Restore Records

Device List
= @ Q Sea

IP Address Alias Name Group
10.81.10.10 EDS-510E Root
10.81.10.11 EDS-510E Root
10.81.10.12 EDS-510E Root
10.81.10.13 EDS-510E Root

10.81.10.14 EDR-810 Root

O0O0o0oo0oo
gooooOo

10.81.10.15 EDS-510E Root

(Optional) Filter the devices in the Device List:

a. Click the Filter (<) icon.

b. Specify any of the following criteria:
O Group: The group in the MXview One tree structure that the device is assigned to
O IP Address: The IP address of the device

c. Click Apply.
MXview One filters the Device List according to the specified criteria.

To export the device list from all available devices:

a. Click the Export (@) icon.

[+

Export CSV

O

MXview One exports the 'All available devices' list as a CSV file.
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5. To back up configurations from specific devices:

a.

b.

C.

Select the check box next to the device(s) you want to back up.

Click the Backup (B) icon in either of the following locations:
O For a single device, click the Backup (B) next to the selected device.

O For multiple devices, click the Backup (B) icon in the upper left corner of the screen.

The Backup Configuration screen appears.

Back Up Configuration

MXview One will archive these configuration files
192.168.127.152
192.168.127.153
192.168.127.154
192.168.127.155
192.168.127.156

Click Save.

MXview One archives configuration files from selected device(s) to the MXview One server and
displays them in the Records tab. Also, MXview One will export configurations from the selected
device(s) as a ZIP file.

For more information, please see the following topics:
Comparing Archived Configuration Files

/7 NOTE

If MXview One compares two configuration files and they are the same, it will only leave the latest one. If
the two configuration files are different, MXview One will keep both in the Records tab.
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Restoring Device Configurations

Use the Configuration Center screen to restore configurations to one or more devices by restoring an
archived configuration from the MXview One server or importing a local configuration backup file (in INI
format).
1. Navigate to Menu (E) > Device Configuration Center.

The Device Configuration Center screen will appear.
2. Click the Restore tab.

Available devices will appear in the Device List.

Configuration Center

Backup Restore Records

Device List
=@ Q_ Searct

IP Address Alias Name Group
10.81.10.10 EDS-510E Root
10.81.10.11 EDS-510E Root
10.81.10.12 EDS-510E Root
10.81.10.13 EDS-510E Root

10.81.10.14 EDR-810 Root

OOOOOO

10.81.10.15 EDS-510E Root

3. (Optional) Filter the devices in the Device List:
a. Click the Filter (<) icon.
b. Specify any of the following criteria:
O Group: The group that the device is assigned to
O IP Address: The IP address of the device
c. Click Apply.
MXview One filters the Device List according to the specified criteria.
4. (Optional) Export configurations from all available devices:

a. Click the Export (E) icon.

a o

Export CSV

O

b. Select Export CSV.
MXview One exports the 'All available devices' list as a CSV file.

5. To restore an archived configuration file to a device:

a. Click the Restore ({9) icon next to the IP Address of a device in the Device List.

The Restore Configuration screen will appear.

Restore Configuration

Restore Device - 10.81.10.11

Restore Configuration ¥
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b. From the Restore Configuration drop-down list, select the archived device configuration to

restore.

Restore Configuration

Restore Device - 10.81.10.11

g et e

Local File

10.82.10.3_20210805_2223.ini

10.82.10.3_20210805_2304.ini

10.82.10.3_20210806_1109.ini

10.81.10.11_20200722_1722.ini

c. Click Apply.

Restore Configuration

Restore Device - 10.81.10.11

Restore Configuration

10.81.10.11_20200722_1722.ini -

Createing Time: 2021-09-22 10:10:00
Last Checking Time: 2020-11-26 10:47:00

MXview One imports the configuration file to the selected device.
6. To import a local configuration file to a device:

a. Click the Restore (@) icon next to the IP Address of a device in the Device List.

The Restore Configuration screen appears.

Restore Configuration

Restore Device - 10.81.10.11

Restore Configuration >

Cancel Apply

b. From the Restore Configuration drop-down list, select Local File.

MXview One 1.2.0 User Manual

129



c. Click the Configuration File field to a select the configuration file.
Restore Configuration

Restore Device- 10.81.10.11

Restore Configuration

Local File -
Configuration File O

d. Select the configuration file to import and click Open.
e. Click Apply.

Restore Configuration
Restore Device - 10.81.10.11

Local File A

Configuration File

10.81.10.11.inj O

MXview One imports the configuration file to the selected device.

Comparing Archived Configuration Files

Use the Device Configuration Center to compare changes in the history of saved configuration files.

1. Navigate to Menu (E) > Device Configuration Center.
The Device Configuration Center screen appears.
2. Click the Records tab.

A list of archived backup configuration files appears.

Configuration Center

Backup Restore Records

Configuration File

=@

Configuration File Createing Time Last Checking Time
a i !:l 10.82.10.3_20210805_2223.ini 2021-09-22 10:10:00 2021-08-05 22:23:00
a i !ﬂ 10.82.10.3_20210805_2304.ini 2021-09-22 10:10:00 2021-08-05 23:04:00
B § M) 1082103.20210806_1109.ini 2021-09-2210:10:00  2021-08-06 11:09:00
B i !:l 10.81.10.11_20200722_1722.ini 2021-09-22 10:10:00 2020-11-26 10:47:00
IS | l;l 10.81.10.11_20210409_1812.ini 2021-09-2210:10:00  2021-04-09 18:12:00
B 8§ M) 1081.10.12.20201211_1508.ini 2021-09-2210:10:00  2020-12-11 15:08:00
B 8 M) 1081.10.12.20210409_1812ini 2021-09-2210:10:00  2021-08-05 23:04:00
a i !J 10.85.10.20_20201215_1342.ini 2021-09-22 10:10:00 2020-12-15 13:42:00
a i !J 10.85.10.30_20201215_1358.ini 2021-09-22 10:10:00 2021-04-09 18:13:00
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3. (Optional) Filter the list of configuration files:
a. Click the Filter (<) icon.
b. Specify any of the following criteria:
Group: The group that the device is assigned to
Start Date: The earliest file creation date
Start Time: The earliest file creation time on the Start Date
End Date: The latest file creation or update date

[ R R Ry |

End Time: The latest file creation or update time on the End Date
c. Click Apply.
4. (Optional) Export configurations from all available devices:

a. Click the Export (E) icon.

[+ I

O Export CSV
b. Select Export CSV.
MXview One exports all the devices information as a CSV file.

5. Click the Compare (“) icon next to the configuration file you want to compare.
The Compare Configurations screen will appear.

Compare Configurations

Compare Basement: 192.168.127.13_20220503_1818.ini

Device List *

192.168.127.13

Compare Target

192.168.127.13_20220503_1819.ini -

7. Select the target configuration file to compare from the Compare Target drop-down list.

6. Select the device from the Device List drop-down list.
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8. Click Compare.
MXview One will display a comparison of the selected configuration files.

Compare Configurations

Compare Basement: 192.168.127.13_20220503_1818.ini

192.168.127.13

are Target

192.168.127.13_20220503_1819.ini ¥

ey e mmeie e ——

# [SwitchName]: Switch Name

# --> max. length = 35 words

SwitchName Managed Redundant Switch ©281@
# [Location]: Switch Location
# --> max. length = 8@ words

¥ ; et :

+ Location Switch Location Test

# [SysDescr]: Switch Description
# --> max. length = 3@ words
SysDescr EDS-483A

The inserted, deleted, and modified lines in the configuration will be highlighted.

/7  NOTE

The green lines are the configurations of Compare Target. The red lines are the configurations of Compare
basement.

Creating Maintenance Scheduler for
Database/Configuration Backups

Use the Maintenance Scheduler to automatically export/import device configurations or back up the
MXview One database on a predefined schedule.
1. Navigate to Menu (E) > Administration > Maintenance Scheduler.
The Maintenance Scheduler screen appears.
2. (Optional) Search a previously saved scheduled job, type a job name in the search box.
The Maintenance Scheduler table displays a list of matching scheduled jobs.
3. Click the Add (E3) button.
The Add job screen appears.
Specify the Job Name.
5. Select one of the following options from the Action drop-down box:
> Export Configuration
> Import Configuration
> Database Backup
Type a Description for the job.
Select the Registered Devices that apply.
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8. Select a job frequency from the Repeat Execution drop-down box:

>
>
>
>

9. Specify the Start Date to begin executing the scheduled job.
10. Specify the Execution Time on the Start Date to run the scheduled job.

Once
Daily
Weekly
Monthly

11. Click Add.

MXview One will display the scheduled job on the Maintenance Scheduler table and will execute the

job according to the defined schedule.
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14. Custom Integrations

MXview One supports several features that enable integration with third-party applications or external
systems.

Managing RESTful API Keys

MXview One supports RESTful APIs for custom integrations with third-party products. Use the API Key
Management screen to add new applications and generate API keys.
1. Navigate to Menu (E) > Integration > API Key Management.

The API Key Management screen will appear.

API Key Management

Q_ search
[ Application Name Create Time Access Count API Key
eyJhbGeiOiJIUZINilsINRSCCI6IKpXVCJ9.eyJ1c2VybmFtZSIsinRyeW14dmlldylsimihdCIGMTY

[ test 2021-10-2810:20:10 183 2ZNTM4NZYxMCwianRpljoiNWEYN2E4ZGY2Y2NiYjZhOGY1ZjkwN2JIOTIIMGVKY TUyYWYyZWQ
4MiJ9.i9ZVczIAOES00TIrD7bmwSv1LJIXhp17JAr8YDZ5Q0uA

2. (Optional) Search the list of applications, type a string in the search box.

MXview One filters the list of applications to display only the applications that contain full or partial
matching strings.

3. To add a new API key for an application:
a. Click the Add () icon in the top left corner of the screen.
The Add New Token screen will appear.

Add New Token
Application Name *

Cancel

b. Specify an Application Name.
c. Click Add.

MXview One will add the new application to the API Key Management screen and display the
generated API key.

4. To regenerate an API key for an existing application:
a. Select the check box next to the Application Name.

The Regenerate the API Key (@) icon will appear in the top left corner of the screen.

API Key Management

C Q_ searct
Application Name  Create Time Access Count APl Key

eyJhbGeiOiJIUZINiIsINRSCCIBIKpXVCJ.eyJ1c2VybmFtZSI6inRyeW1 4dmildylsimihdCISMTY
test 2021-10-2810:20:10 183 ZNTMANZYxMCwianRpljoiNWEYN2E4ZGY2Y2NiYjZhOGY1ZjkwN2JIOTIMGVKY TUYYWYyZWQ

4MiJ9.i9ZVczIAOES001IrD7bmwSv1LJXhp17JAr8YDZ5Q0UA

MXview One 1.2.0 User Manual 134



b. Click the Regenerate the API Key (G) icon.

MXview One will regenerate the API key for the selected application.

/7  NOTE

Regenerating the API key will prevent any APIs that use the old API key from working properly.

5. To delete an application:
a. Select the check box next to the Application Name.
b. Click the Delete (i) icon in the top left corner of the screen.
MXview One will delete the application.

/  NOTE

Deleting the application will prevent any APIs that use the old API key from working properly.

6. To view API reference documentation, navigate to Menu (E) > Help > API Documentation.

The MXview One API screen will appear and display the reference document for supported MXview
One APIs. Click API user guide below the MXview One API title, where you can find the guidelines for
using the RESTful API functions.

MXview One AP| <2

A document of API for accessing data from MXview One

AP user guide

Servers

http://127.0.0.1/ v

Resource v

/resources/icons/url/{url} Getdeviceicon

/resources/icons/{url} Get the icon of a site

GET /resources/panel_images/url/{url} Getthe panelimage of a device

Embedding Web Widgets

MXview One allows you to embed the Topology Map and Recent Events widgets from the MXview One
Topology screen in third-party applications.
1. Navigate to Menu (E) > Integration > Embedded Web Widget.
The Embedded Web Widget screen will appear.
2. From the Select API Key drop-down list, select the Application Name for the API key you want to
use.

Select APl key

Demo v
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3. From the Select Layout drop-down list, select the widget(s) you want to embed:
> Topology and Recent Events: Embeds both the Topology Map and Recent Events widgets in the
target application
> Topology: Embeds only the Topology Map in the target application
» Recent event: Embeds only the Recent Events widget in the target application
4. Copy and paste the widget link for the target application:
> To embed the widget in a web application, click the Copy link (0) icon in the Link section.

Embed
Link
hitp/127 0.0 1!#ledget9

Paste this into any HTML page

<iframe id="mxview-topology"
src="http://127.0.0.1/#/widget?
token=eyJhbGciOiJIUzI1NilsInR5cCI6IkpXWC
J9.eyJ1c2VwbmFZSI8ImFkbWiuliwiaWFOljox
NTQyMTczODYzLCJqdGkiOilzMzFIZjQ2ZDAQ
3NJIOZDec2MMIMDM4Z]VhODRjNzAzMzBhY
ml0YzgzIn0.FoxRT2wxtsm_75QXFOnacD-
0PBBIzUSINS wUsrPFnk&layout=2&top=1&b
ottom=2" frameborder="0" scrolling="0"
style="border-radius: 2px; box-shadow:
rgba(0, 0, 0, 0.12) Opx Opx 2px Opx, rgba(0, 0,
0, 0.24) Opx 2px 2px Opx; width: 600px;
height: 600px;"=</iframe= I

» To embed the link in a static HTML page, click the Copy link (D) icon in the Paste this into any
HTML page section.

Embed
Link

http /1127 0.0 1/#widget?
token=eyJhbGciOiJIUzI1NilsInR5cCl6lkpXWVC
J9.eyJ1c2WybmFtZSIGImFkbWIuliwiaWFOljox
NTQyMTczODYzLCJqdGkiQilzMzFIZjQ2ZDQ
INJIOZDe2MVIMDM4ZIVhODRINzAzMzBhY
ml0YzgzIn0. FoxRT2wxtsm_75QXFCOnacD-
0PB6IzUSINS wUsrPFnk&layout=2&top=1&b
ottom=2 0

Paste this into any HTML page

<iframe id="mxview-topology"
src="http://127.0.0.1/#/widget?

D, 0. 24) t]px 2px 2px Opx;
he ght: 600px;"=</iirame:
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15. Wireless Add-on Module

MXview One supports several optional modules that extend the functionality of the main module. These
modules require a separate license to use.

Introduction

The MXview One Wireless Add-on Module provides a set of tools to help you monitor and troubleshoot your
wireless network through MXview One and supports up to a total of 200 wireless APs and clients. The add-
on gives you clear, real-time information about the status of your wireless network including the client
roaming status and key wireless performance indicators such as SNR and noise level. The wireless module
also instantly notifies you of any problems with your wireless devices and helps you narrow down the root
cause of the problem, allowing for quick and easy troubleshooting.

System Requirements

The computer that the MXview One Wireless Add-on Module is installed on must satisfy the following system
requirements based on the maximum capacity of 200 wireless APs and clients:

; System Requirements

CPU 2 GHz or faster dual core CPU
RAM 8 GB or higher
Hard Disk Space 20 to 30 GB for 1 month of performance and event history recording

Windows 10 (64-bit)

Windows 11 (64-bit)

Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Chrome: Version 76 or later
Browser Requirements Firefox: Version 69 or later
Microsoft Edge: Version 79 or later

0s

Supported Devices

The MXview One Wireless Add-on Module supports the following wireless devices:

e AWK-3131A Series (firmware v1.16 or higher)
e AWK-4131A Series (firmware v1.16 or higher)
e AWK-1131A Series (firmware v1.22 or higher)
e AWK-1137C Series (firmware v1.6 or higher)
e AWK-1151C Series (firmware v2.0 or higher)
e AWK-3252A Series (firmware v2.0 or higher)
e AWK-4252A Series (firmware v2.0 or higher)
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Getting Started With the Wireless Add-on
Module

In order to use the MXview One Wireless Add-on module, you will need to activate it first. You can choose to
activate a new license, or enable the wireless 60-Day free trial through the license management page.

License Management

MXview One )
License Wireless Add-on License

Mode: Authorized Mode: Authorized

Current Nodes: 47

Licensed Nodes: 250

— Moxa License Site [

Add New License License Type

Licenses v

Re-activate License

Use both the Deactivation Code and a
User Code to re-activate your license.

Re-activate

The system will automatically restart after you activate the module. A message will appear telling you to
wait 10 seconds while the module activates. Once done, click OK to refresh your browser and enable the
Wireless Add-on features.

Please Wait

The operation will finish in 10 seconds.

OK

e  For detailed information on how to activate the MXview One Wireless Add-on Module, refer to License
Management.

e To add wireless devices to your MXview One network, refer to Using Device Discovery.

/ NOTE

Please activate the Node-based License first and then the Wireless Add-on License.
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Wireless Module Features

The MXview One Wireless Add-on Module offers a set of features specifically designed to help you monitor
and troubleshoot your wireless network more easily.

Main Dashboard

If the wireless module is activated, the MXview One Dashboard will show two additional types of
information: AP Traffic load and the Wireless Device Summary.

The AP Traffic Load graph shows the aggregated traffic of all the AP devices monitored by MXview One. You
can select a specific time to check the wireless network status at that time. MXview One provides three time
sections: Last 24 hours, Last week, and Last 2 weeks.

The Wireless Device Summary shows the number of deployed wireless devices. Clicking one of the cards will
direct you to the Wireless Device Summary screen where you can find more detailed information about the
wireless devices. Refer to Chapter 5: Dashboard Widgets for more information about the other cards on
the dashboard.

To access the Dashboard, navigate to Menu (E) > Dashboard.

To refresh the data displayed in all the widgets, click the Settings ( i) icon in the top-right corner of the
screen and select Refresh All.

Dashboard

AP Traffic Load Last 24 hours - )
— Last Update: 2022-05-12 14:06:30 C

19.53KB/s
17.58 KB/s
15.63KB/s
13.67 KB/s

11.72KB/s

13:30 13:35 13:40 1345 13:50 13:55 14:00
5/12/22
UTC +08:00
Time: - O Input: - [ Output:
[S)E;Irll(;:ary de«c:;”zjgw 2022-05-12 c Event Highlights Last Update: 2022-05-12 14:07:30 (¥
28 -
0 21
Healthy Devices ~ Warning Devices Critical Devices
]
3 14
I I o
View Network Topology. 7
0
Wireless Device Last Update: 2022-05-12 c 05/06 05/07 05/08 05/09 05/10 05/11 05/12
14:07:29
Summary @ Cold/Warm Start Trap @ ICMP Unreachable [ Link Down
AP Devices Client Devices

View Network Topology,
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Dynamic Wireless Client Roaming

The MXview One Wireless Add-on Module features dynamic wireless roaming display, which updates
roaming connections of wireless clients in real-time. Instead of using LLDP data to draw links between

devices, MXview One uses both the client list data from the wireless AP and AP data from the wireless client
to detect wireless roaming changes.

To enable the dynamic wireless client roaming function, toggle the Dynamic client position option. In this
mode, wireless clients will automatically move below the AP they connect to when roaming. The link
between the client and AP on the topology will also change dynamically if the client connects to another AP.

Refer to the table below for a description of each display option.

Option Descripton

. Toggle this option on or off to show or hide wireless clients on the
Show clients
topology
Enable this option to have wireless clients move to a position close to
Dynamic client position the AP they are associated with
Disabling this option will return the clients to their original position

s Topology v e Group v g Edit v @ Visualization v @ SFP v = Wireless v
Q,
AP
Wireless display options X J,]

@@ show clients
™ Dynamic client position o

192.168:127.168

Device IP
Device Role Client
Bottom Label J.|

Port Number
192.168.127.165
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The following diagrams are an example of the dynamic roaming display showing dynamic client-AP link
changes.

In the first scenario there are two wireless APs that each have one client connected to it.

Client
192.168.127.766 168.127.152
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.
N
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.
2
.
N
“hpa p5
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.
.
i
.
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I .
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.
.
192.168.127.153
. 192.168.127.167

192.168.127.165

When the client roams to another AP, MXview One will automatically redraw the link to the new AP on the
wireless topology diagram.

Client
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AP /Client Device Dashboard

Use the AP/Client Device Dashboard screens to see detailed information and performance statistics of
the client or AP.

To access the AP/Client Device Dashboard, click on any wireless AP or client device’s icon on the topology
diagram and click Device Dashboard in the toolbar.

9 Locator @D Add Link BY Device Dashboard B Delete

AP Device Dashboard

AP Dashboard-192.168.127.169--AWK-4131A

Q Filter Client Count Security Mode TX Power Uptime

1T /7 2 Open 12 dBm 0d 1hr 48min
ed  Connected

06:90:E8:7C:C3:01 ~
Last 30 minutes = c
J 192.168.127.166
Traffic Load

14.65KB/s  —
9.77 KB/s .

488KBfs

13035 13:10 1315 13:20

UTC +08:00

Time: - O Rx: - O

The device's firmware version is not supported

Close
The AP Device Dashboard shows the following information:

Monitored The total number of wireless clients connected to this AP that are monitored
Client Count by MXview One

Connected |The total number of wireless clients that are connected to this AP

Security Mode The Security Mode of the AP: Open, WEP, WPA, or WPA2

TX Power The current transmission power of the AP

Uptime The total time the wireless AP has been online since the last restart

Traffic Load The current and historical traffic throughput of the wireless interface

CPU Usage The Furrent and historical CPU usage of the AP (only supported by certain firmware
versions)
The current and historical memory usage of the AP (only supported by certain firmware

Mem e .
ory Usag versions)
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Client Device Dashboard

Client Dashboard-192.168.127.166--AWK-1137C

BSSID Security Mode Link Speed Connected

06:90:E8:7C:C3:01 Open 58 Mbps 0d 2hr 50min

Last 1 hours C

SNR
80dEm AP I T N N i A P e A Y e
50dBm
40dBm
30dBm B N N N . W B o N R o e Y B Y W e
12:55 13:00 13:05 1310 1315 13:20 13:25 13:30 13:35 13:40 13:45 13:50
12/25/20
UTC +08:00
Time: -- []SNR-A: - [1SNR-B: -

Signal Strength
70dBm
Ol “ *
60dBm |~ |J

Close

The Client Device Dashboard shows the following information:

Parameter Description

BSSID The BSSID of the wireless AP the client is connected to

Security Mode The Security Mode of the client: Open, WEP, WPA, or WPA2

Link Speed The real-time bandwidth of the connection to the AP

Connected The total time the wireless client has been connected to the AP
The current and historical Signal-to-Noise ratio of the client

SNR If the wireless device has multiple antennas, the SNR of each antenna will be
separately shown as SNR-A and SNR-B

Signal Strength The current and historical signal strength of the client

Noise Floor The current and historical noise floor of the client

Traffic Load The current and historical traffic throughput of the wireless interface

CPU Usage The current ar_1d historical CPU usage of the client (only supported by certain
firmware versions)

Memory Usage The current ar.1d historical memory usage of the client (only supported by certain
firmware versions)
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You can view the device diagnostics and usage parameters in real-time or recall the history for up to the
last 3 days from the drop-down menu in the top-right. You can zoom in on the timeline to examine a
narrower time period. Double-click the timeline to return to the original view.

From now c
. From now
Traffic Load
Last 30 minutes
3.32KBfs
313 KBfs Last 1 hour
2.93 KB/s

Last 3 hours

1016 10017 10:18 1019 10:20 10:21 10:22 10:23 il

Last 24 hours 26
5/25/22

UTC +08:00
Last 3 days
Time: - O rx: - OTx: 1

Wireless Device Summary

The Wireless Device Summary screen provides detailed information about all the AP and client devices
including the device’s IP and MAC address, operation mode, and current signal strength.

To access the Wireless Device Summary screen, expand the Wireless (?) menu in the toolbar and click
Wireless Device Summary.

Click Back in the top-left corner to return to the topology view.
& Back

Wireless Device Summary

All (5)
c Qse
AP(2)
Operation Mode  IP Address. MAC Address BSSID Channel  Noise Floor = Signal Strength (dBm)
—— Client (3)
> A AP -192.168.127.168 (Site Name: Site BRANDONYANG-PC / MAC Address: 00:90:E8:52:39:50 / Channel: 1)
== Client 192.168.127.165 00:90:E8:52:39:75 06:90:E8:52:39:50 1 -88 23
A AP - 192.168.127.169 (Site Name: Site BRANDONYANG-PC / MAC Address: 00:90:E8:7C:C3:01 / Channel: 1)
== Client 192.168.127.166 00:90:E8:63:A7:6C 06:90:E8:7C:C3:01 1 a1 22
A Unmanaged AP (Site Name: Site BRANDONYANG-PC)
== Client 192.168.127.167 00:90:E8:52:07:85 N/A 1 N/A N/A
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Wireless Roaming Playback

Through the Wireless Roaming Playback screen, you can recall the roaming history of a specific client. By
default, MXview One will keep the roaming playback data for 30 days.

To access the Wireless Roaming Playback screen, expand the Wireless (?) menu in the toolbar and click
Wireless Roaming Playback.

Click Back in the top-left corner to return to the topology view.

All > client-wireless > Root

< Back

Q_Filter

ap AP
MOXA & i

192164126.92
J 192.168.126.101 Ciknt |2022.05-1015:13:10

RSSI: 53

BEER

192.168.126.101

i, oate Start Time Ouration
OTimeRange: 5102022 B FF o216 O  6hr ¥ m

From To
20220510 20220510
o ° » 150720

15:35:11

0310 0315 0320 0325 0330 033

On the left-hand side is a list of wireless clients, in the center is the topology map, and located at the

bottom is the playback progress bar. Select any client from the list and click Play (°) to start playing the
wireless roaming history for the selected time range. You can adjust the playback speed by clicking the

Decrease Speed (“ ) or Increase Speed (™ ) button to increase or decrease the playback speed
respectively.
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To view the history for a specific time and date, click ( = ) to choose the starting date, set the time in the

Start Time field, select the duration of the playback history from the Duration drop-down menu, and click

Apply.
_ Date Start Time Duration
O TimeRange: 1/92/2021 [}  08:58 CRERL v m
DEC 2020 ~ < >
DEC
1 2 3 4 5
6 7 8 9 10 11 12
13 4 15 16 17 18 19
20 21 22 23 24 @ 26
27 28 29 30 )l
“DatE BErTTmE

ange:  12/25/2020

= 01:42 PM

©

The progress bar also displays the RSSI value at the time. In addition, the red dots indicate the time when
the wireless client roamed to a different AP. You can zoom in on the timeline to examine a narrower time
period. Click Apply to return to the original view.

2020-12-25 12:03:25

1x From
RY » S

RSSI: 66

=

To
20201225
15:42:00
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16. Power Add-on Module

MXview One supports several optional modules that extend the functionality of the main module. These
modules require a separate license to use.

Introduction

The MXview Power Add-on Module provides a set of features to help you monitor and troubleshoot your
power substation network that follows the IEC 61850 standard and supports switches that have the
PRP/HSR function with deep visualization. To monitor the IED (Intelligent Electronic Device), which is an
important device that can receive data and issue commands on the network, MXview Power supports the
MMS protocol to view and provide the status of the IED. Furthermore, there is a critical packet called
GOOSE in power substation networks, and MXview Power can also help customers troubleshoot GOOSE
events such as GOOSE Timeout and GOOSE Tampered. The power module instantly notifies you of any
problems with your power devices and helps you narrow down the root cause of the problem, allowing for
quick and easy troubleshooting.

System Requirements

The computer that the MXview Power Add-on Module is installed on must satisfy the same system
requirements as those required for MXview One. See System Requirements in Chapter 1 for more
information.

Supported Devices With PRP/HSR Features

PRP/HSR features can be visualized with the devices that support PRP/HSR functions or have a PRP/HSR
module.

e PT-G503 Series (firmware v5.1 or higher)

e PT-G510 Series (firmware v6.4 or higher)

e PT-G7728 Series and LM-7000H-2GPHR module (firmware v6.2 or higher)

e DA-820C Series and DN-PRP-HSR-1210 or DA-PRP-HSR-I210 (OS Win 10 or higher)
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Getting Started With the Power Add-on Module

In order to use the MXview Power Add-on module, you will need to activate it first. You can choose to
activate a new license or enable the Power 60-day free version through the License Management page.

License Management

MXview One ()
License Power Add-on License

Mode: Authorized Mode: Authorized

Current Nodes: 0

Licensed Nodes: 3

o,
|2
| Moxa License Site (4

Re-activate License

&

Use both the Deactivation Code and a
User Code to re-activate your license.

Re-activate

The system will automatically restart after you activate the module. A message will appear telling you to
wait 10 seconds while the module activates. Once done, click OK to refresh your browser and enable the

Power Add-on features.

Activating...

The operation will finish in 10 seconds.

e For detailed information on how to activate the MXview Power Add-on Module, refer to Chapter 4:

License Management.
e To add power devices to your MXview One network, refer to Using Device Discovery.

/7  NOTE

Please activate the Node-based License and then the Power Add-on License.
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Power Module Features

The MXview Power Add-on Module offers a set of features specifically designed to help you monitor and
troubleshoot your power substation network more easily.

= MXview ONE @eglisn 2 adminy
Al > Site DESKTOP-LBCNQNO > Root
ATopoy v @Gopv  SEav @ Viwlionv  etSPv § Powerv

[}
Q

sssss

1=

FRIEE

Topology

After you enable the MXview Power add-on module, you will see the panel has changed on the left hand-
side.

GOOSE panel

1. Before you import the SCD file, the GOOSE panel will be displayed in light gray. At this point, it has

limited functionality.
|

2. Once you have imported the SCD file via Power > Import SCD, you can find the IED as a GOOSE

publisher identity via the GOOSE panel.
a. Click GOOSE panel.

Q

GOOSE
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b. Scroll down or type the GOOSE-related information, such as IED name or GoCB name.

= MXview ONE

All > Site DESKTOP-LBCNQMO > Root

K Maintenance '\ Tools j‘ Change G

Choose a GODSE publisher
REF&620
|
Control_DatasSet
03007 f 01-0C-CDo01:00:07
gcbgebtest
00001 f 01-0C-CC-01:00:02
REF615

gchGOOSE -
?::EII:IEIE F01-0C-CD-01:00:0:5 m

Display Options
1. Once you have activated the MXview Power add-on module, you can see the display options include
extra functions such as PRP LAN A, PRP LAN B, and HSR Ring.

2. If the box is checked, you can see the color of the link for the PRP/HSR on the topology. If you uncheck
the box, then the link will not display the color for the PRP/HSR function.

splay options p-¢
>
ga Device IP
Device Role
Bottom Label
Port Number

B PRP LAN A
B PRP LAN B
B HSR Ring

/  NOTE

PRP LAN A is represented by a green line, PRP LAN B by a blue line, and HSR Ring by a purple line.

/  NOTE

MXview One cannot guarantee that it can draw the link of the topology for non LLDP devices, such as an
IED device. However, you can draw the link of the topology manually by clicking Add Link.
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Import SCD

The SCD (Substation Configuration Description) file includes the information of the critical packet - GOOSE
message in the network. To visualize the GOOSE message flow in MXview Power, the user has to import the

SCD file.
1. Navigate to Menu (E) > Topology

The Topology screen will appear and display the Topology Map by default.

2. To import the SCD file to the Topology Map:
a. Click Power > Import SCD.
The Import SCD screen will appear.

Import SCD

—— ——

GOOSE Publisher -

GooseCB
0x01 / 01:0e:c:01:00:01

Subscriber Publisher

GOOSE Timeout

I E
0x01 / 01:0c:0d:01:00:03

Visualize GOOSE Messages
To visualize GOOSE messages between IEDs, you must import an SCD

file first

Select File * ]

Cancel

b. Upload the SCD file by using one of the following methods:
3O The file size must be less than 100 MB.
O Click File (D) icon to upload the SCD file.

3. Click Import.
MXview Power will import the uploaded SCD file into the Topology Map.
If the SCD file is correct, the user will see the message below.

SCD File Import Successful

GOOSE messages and flow design successfully built into the network
topology.

Close
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If the SCD file content cannot find the devices in the Topology, then MXview Power will display the
missing devices and provide the steps for the user to resolve the problem.

Failed to Import SCD File

A Can't find the following device(s):

192.168.127.4

Try these steps to resolve issues.

1. Add the missing device(s)
Click "Edit" = "Add Device".

2. Import the SCD file again
Click "Power" = "Import SCD".

Close

GOOSE Message

MXview Power can display the GOOSE Message information on the Topology or in the IED Device Property
panel by importing the SCD file. Moxa’s PT switch, which was specifically designed for use in power
substation systems, can detect GOOSE events. MXview Power can collect the GOOSE events and alert users
when there is something wrong. Users can follow the step-by-step guidelines to solve the GOOSE events.

GOOSE Flow

There are two roles for IED device(s): Subscriber and Publisher. The topology displays the flow of the
GOOSE packet, which starts from the Publisher and ends at the Subscriber. The route you see on the
GOOSE flow is not the completed GOOSE packet publishing direction. The purpose of displaying the GOOSE
flow is to troubleshoot the path of the GOOSE packet for certain cases such as a GOOSE event (e.g. GOOSE
Timeout, GOOSE Tampered), a device malfunction, or a link going down. The GOOSE flow will show the path
the packet took to enable faster troubleshooting and minimize substation network recovery times.

= MXview ONE @English 2 adminy.

All > Site DESKTOP-LECNGNO > Root
A wamenance v R Took v/ ChngeGrop G Refsh G0 Addlink W PRPHSRTags [ Delere - e

Q Device Properies: Current Statis:

coose IE—‘ MMs Properties

REFS15.

108.10.53.15-A88

GOOSE Publisher v

9ebG00SE
0:0002/01:00C0010005
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GOOSE Timeout

When a GOOSE Timeout event happens, MXview Power can display the event and indicate the possibly
affected devices on the Topology by placing a yellow triangle next to them. When users click on the IED
device, it will display the specific GOOSE message and will also include a Timeout status notification.

= MXview ONE @elisn 2 adminy
All > Site DESKTOP-LECNGNO > Root
R waintenance v W\ Tools v/ CrangeGrowp  C Refresh  GD AddLink B PRPHSRTags [ Delete - @
.
e |= s Proprtes
ol
= ReFsts
s
seo
a

Basic Device Properties.

e
108.10.53.15-A85

‘GOOSE Timeout was caused by
Port 210 108.10.53.7

GOOSE Pubisher -

ocb00sE
T e

Click the How to resolve link and MXview Power will provide you with step-by-step instructions to solve
the problem.

Resolve GOOSE Timeout Issue

A\ GOOSE Timeout was caused by:

Port 21 of 108.10.53.7

Try these steps to resolve GOOSE Timeout issues.

1. Check the IED(s) settings

Make sure the GOOSE publish/subscribe messages of the |ED are set correctly.

2. Make sure the port is not in link down status

Check to make sure the port of each device in the GOOSE flow (gcbGOOSE/0x0002/01:0C:CD:01:00:05) is not in link down status.
3. Make sure the port does not have any TX/RX ermors

Click on a link, choose "Link Traffic” to see the "Packet Error Rate” section. Make sure the port does not have any errors.

4. Check if the fiber ports exceed certain thresholds

Click "SFP" = "SFP List". Make sure the ports do not exceed certain thresholds.

Still not working?

Remove the SFP module and install it again.

If you have further questions, contact your channel partner g first.
Contact Moxa Technical Support ¢ if you still need additional support.

Close

Once the problem is solved, MXview Power will provide the recovery status in the Recent Event panel and
the yellow triangle will disappear.
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GOOSE Tampered

When a GOOSE Tampered event happens, MXview Power can display the event and provide the possibly
affected devices on the Topology by placing a red triangle next to them. When users click on the IED device,
it will display the specific GOOSE message and will also include a Tampered status notification.

All > Site DESKTOP-LBCNONO > Root

R wanenance v A Took v/ ChgeGop G Refesh G0 AddLink W PREMSRTigs [ Delete

a Device Properies: Cuarent Stans

|=

a &

Bl Basic Device Properties

e
GOOSE Port Tampered was caused by: 108.10.53.15-A88
Port30f 108.10.535

,
= -

WiCAdiess

o

)| GoosE puslisher v

ocb00sE
0002/ or0ccooronos MES

Click the How to resolve link and MXview Power will provide you with step-by-step instructions to solve
the problem.

Resolve GOOSE Port Tampered Issue

A\ GOOSE Port Tampered was caused by:

Port 30f 108.10.53.5

Try these steps to resolve the GOOSE Port Tampered issue

1. Check the IED(s) settings
Make sure the GOOSE publish/subscribe messages of the IED are set correctly.

2. Check the port status
Flease check port 3 status of 108.10.53.5.

Still not working?

If you have further questions, contact your channel partner G5 first.
Contact Moxa Technical Support ¢ if you still need additional support.

Close

In order to enhance security, MXview Power allows users to click the Reset button to clear the events log
for the devices. Once the event logs are cleared, MXview Power will provide the recovery status in the
Recent Event panel and the red triangle will disappear.

GOOSE Port Tampered was caused by:
t ﬁ Port 3 0of 108.10.53.5
¥
- How to resolve?
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